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Chapter 1 Introduction

Objective 
This paper will present two highly available IBM® Rational® ClearCase architectures which can be 
setup on Linux for System z®. This paper documents a proof of concept (POC), providing detailed 
instructions for the installation and configuration environment.  Values specific to that POC are used.

Background

High Availability
High Availability is a broad term which needs to be defined further in terms of what is the recovery 
time objective.  This paper assumes the definition is a seamless failover to the end user with less that 1 
minute outage with zero data loss.  Seamless is defined as no action is required to the client for 
redirection to another system. If a request fails, however,  it might need to be reentered.  

On Linux for System z there are a number of products available to help manage and automate the tasks 
required to make applications highly available.  This paper has selected  Tivoli® Service Automation 
for Multiplatforms (TSAMP).  Advantages of TSAMP is that it is fully supported on Linux for System 
z and supported on both Novell® and Red Hat® Linux® distributions. Other options available for 
Linux on System z include Veritas® Cluster Server (VCS), Linux HA and Novell HA extensions.   

Rational ClearCase
IBM Rational ClearCase provides life cycle management and control of software development assets. 
With integrated version control, automated workspace management, parallel development support, 
baseline management, and build and release management, Rational ClearCase provides the capabilities 
needed to create, update, build, deliver, reuse and maintain business-critical assets. 

Four basic components of ClearCase are the ClearCase Registry Server, ClearCase License Server and 
VOB/VIEW server storage locations   
• Versioned Object Base (VOB)– Objects under version control in ClearCase are stored in 

repositories called VOBs
• View in ClearCase determines what version of the file(s) you will be looking at in the VOB
• VOB and VIEW storage locations  are the REPOSITORY which contains metadata about the 

configuration for VOBs and VIEWs. 

A typical ClearCase environment consists of: ClearCase License Server, ClearCase Registry Server, 
ClearCase VOB and VIEW Server that could be shared or hosted separately on their own servers. For 
this proof of concept, the servers are on one machine. 
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A distinguishing feature of ClearCase is a proprietary networked filesystem (MVFS: MultiVersion File 
System), which can be used to mount VOBs as a virtual file system through a dynamic view.Dynamic 
Views are the strategic direction of ClearCase and this paper assumes that they are being used.  They 
are dependant on network connectivity to the VOB,VIEW and repository.  

To support an HA configuration of ClearCase it is required that VOBs, VIEWs storage location 
repositories  reside on a shared disk that is mountable on both the primary and secondary nodes.

Storage options for Linux on System z today includes ECKD,  FCP(SCSI) and Network Attached 
Storage (NAS) disks.
• ECKD and FCP disks reside on the System z server and are available locally to the Linux guests.
• IBM Network Attached Storage (NAS) products provide a wide-range of network attachment 

capabilities to a broad range of host and client systems.

ClearCase requires that remote clients have access to the storage as a mapped drive or mount point. 
This can be accomplished in one of two ways:  Exposing locally mounted storage on the host via 
SAMBA or NFS, or directly attached to a network attached file system like IBM SoNAS.  The current 
IBM Rational ClearCase recommendation  is NAS however there are many clients that still choose to 
expose locally attached storage.  This paper will focus on the use case that exposes locally attached 
ECKD disk via SAMBA and NFS.  The SoNAS (NAS )use case has been tested and some details will 
be provided. 

Performance, preference and management should be considered when deciding the storage option used. 
Although unable to do a full evaluation, this paper will provide some guidance and recommendations. 
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Architecture Use Cases and Design Points

Rational ClearCase will be configured to support an active/standby configuration. The primary 
elements to configure are:
• Setup the Linux on System Z guests with shared storage location area for VOBs and VIEWs 
• Install ClearCase on the active node 
• Install ClearCase on the standby node
• Configure ClearCase on both nodes to use shared disk and common start stop scripts
• Configure the Windows® and Linux® client to allow for remote connectivity to  the active server. 
• Test HA of each node manually prior to setting up automation
• Install and configure TSA for the HA management.
Use Case 1 uses  local ECKD disks. 
Use Case 2 uses an external SoNAS device. 

The scope of this project did not include testing the performance of the local ECKD vs SoNAS.  It was 
found that the shared disk configuration differences were minimal from a configuration/setup 
perspective.  Both options worked with the POC tests.   The shared disk architectures are laid out in 
Case 1 and Case 2 descriptions that follow in this Chapter with some pros and cons  The remaining 
Chapters of the paper focus on the setup work required  to make ClearCase highly available. Most of 
the setup is the same regardless of the shared storage option used.   The paper was written from a Case 
1 ECKD shared disk configuration perspective.  The differences for a Case 2 SoNAS configuration are 
highlighted where appropriate.
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Use case 1 Active/Standby Configuration With ECKD Storage
ClearCase will be setup in an active/standby configuration.  The active system will be accessed by the 
clients via a service IP address.  System Automation will be configured to monitor the health of the 
network connection, file system and application.  If issues  arise, automation will attempt to bring the 
primary site down by shutting down ClearCase, unmounting files systems, and moving  the service IP. 
At the same time automation will be mounting the file systems on on the standby node, bringing up 
ClearCase, and taking over the service IP. Since clients are connected via the service IP, they might 
experience a momentary degradation of performance or an error during the switch. Manual intervention 
will not be required by the client.

The storage will be local ECKD disks. All client access to VIEW and VOB storage will be via map or 
mount attached to the host via CIFS(SAMBA) if  using a Microsoft® Windows client or NFS if using 
an Unix based client system. 

Advantages of using ECKD storage
• Existing Linux on System z processes backing up data and disaster recovery can be leveraged.   
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• Leverages high I/O performance rates characteristic of mainframe storage. 

Disadvantages of using ECKD storage
• The storage is shared via the server and  could  cause a performance  bottleneck under high load.   
• A large storage requirement would need complicated logical volume group definitions to be 

manually created to meet storage pool requirements.
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Usescase 2  Active/Standby configuration with Network Attached Storage

As in Usecase 1 ClearCase will be setup in an active/standby configuration.  The active system will be 
accessed by the clients via a service IP address.  System Automation will be configured to monitor the 
health of the network connection, file system and application.  If issues  arise, automation will attempt 
to bring the primary site down by shutting down ClearCase, unmounting files systems, and moving  the 
service IP. At the same time automation will be mounting the file systems on on the standby node, 
bringing up ClearCase, and taking over the service IP. Since clients are connected via the service IP, 
they might experience a momentary degradation of performance or an error during the switch. Manual 
intervention will not be required by the client.

The storage will be Network Attached Storage. All client access to VIEW and VOB storage will be 
drive map or mount to the NAS device  using a Microsoft® Windows client or NFS if using an Unix 
based client system. 
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Advantages of using NAS storage
• Storage shared and managed by appliance device not Linux.  
• If IBM SoNAS is used, additional benefits will be available such as centralized management, 

centrally deployed and Global Parallel  File system support, improving performance, protects 
integrity, and available of shared storage arrays.  

Disadvantages of using NAS storage
• The client workstation setup becomes more complex as clients will need to be configured to point 

directly to the NAS.   
• Today NAS is not a common practice for Linux for System z customers.  
• New processes will have to be created or adopted to provide backup and disaster recovery services. 

IBM SoNAS offers several enterprise class features in these areas which might turn this 
disadvantage into an advantage.
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Chapter 2 Infrastructure and Installation of Rational ClearCase

Architecture

Hardware
System z10 
2 Linux guest servers 

Software
Novell SuSE Enterprise Linux 10 SP3, kernel 2.6.16.60-0.54.5-default
IBM Rational ClearCase V7.1.1.1
IBM Tivoli System Automation V 3.2
Samba 3.0.36-0.5.5
NFS server 2.13.10-0.3

System configuration

Network
Host Name IP Address Purpose

sonnf1.washington.ibm.com 9.82.24.173 Active Node

sonnf2.washington.ibm.com 9.82.24.174 Standby Node

soncc1.wasthington.ibm.com 9.82.24.170 Service IP/Host

sonas.stordemo.wsclab.
washington.ibm.com

9.82.35.51 SoNAS Device

9.82.24.173 (sonnf1.washington.ibm.com)

9.82.24.174

RCC
SAMBA
NFS

RCC
SAMBA
NFS

/opt/ibm/IBMShared/eckd

Linux
Client

Windows
Client RPC/SMB 

RPC/NFS

ECKD
-Registry
-VOB

Service IP
9.82.24.170

/opt/ibm/IBMShared/eckd
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Each node will be available by it's own host name and IP address. When running an active ClearCase 
server, the node will assume the identity of the service IP and host name. To maintain connectivity, the 
hosts file of each server must contain the IP configuration. 

Update /etc/hosts to have the entries for the other elements of the network,  for example:

9.82.24.170     soncc1.washington.ibm.com soncc1

9.82.24.173     sonnf1.washington.ibm.com sonnf1

9.82.24.174     sonnf2.washington.ibm.com sonnf2

9.82.35.51      sonas.stordemo.wsclab.washington.ibm.com sonas 

During the configuration of the software, whenever a hostname is required to refer to the license, 
registry, or VOB server, use the fully qualified hostname, such as soncc1.washington.ibm.com for the 
service address. This will remove ambiguity and avoid connection errors on the client workstation. 

User and Group Considerations
The installation of the ClearCase server is done by the root user. All of the administration and 
configuration tasks upon the server should be done by a unique, dedicated user such as ccadmin as a 
member of group ccgroup.

The infrastructure of this paper includes a ClearCase server on Linux accessed by clients on Windows 
and Linux. Whenever a ClearCase enterprise includes heterogeneous systems, accessing a common set 
of VOBs and views from computers running in mixed environments the following requirements may 
need to be addressed:

• The users and group memberships used to access the VOBs and views must be identical on the 
server and the client. This includes the user ID and group ID along with the names. ccgroup will 
be used as the common group for users accessing ClearCase objects. 

• Client configuration issues and file naming conventions that address differences among the 
supported operating systems in areas such as case sensitivity, line termination in text files, and 
characters that are allowed in file names.

Licensing Considerations
Rational ClearCase can use Rational Common Licensing or ClearCase Licensing. Common Licensing 
requires an external License server that can be accessed by various Rational installations. ClearCase 
Licensing runs with the ClearCase server, does not require additional setup or resources, and can be 
accessed by other ClearCase installations.

This document uses the proprietary Atria Licensing that is installed with ClearCase. The license 
provided to the tool is specific to the ClearCase server hardware. In an HA environment, where one 
server is running at a time, both nodes must have their own specific licenses installed. 
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Installation and Configuration IBM Rational ClearCase V7.1.1.1

Accessing the Linux Guest
The POC installation and configuration of the ClearCase nodes used the graphical interface. Linux on 
System z installations should have a VNC server configured and running by default.

1. Connect through VNC.

On a client workstation, open VNC Viewer and enter the address for the active node, 
sonnf1.washington.ibm.com.

2. Log in as root. Many of the steps will be performed on the command line in a terminal 
window. 

Open a terminal by right clicking the desktop and  selecting “Open Terminal”.

Prepare the Installation Media

1. Rational ClearCase V7.1.1 is part number CZ9XJML. Assuming that this has been 
downloaded or provided as CZ9XJML.zip, move this file to the active node., in directory 
/RCC.

2. Extract the archive by performing the following commands in the terminal. 
cd /RCC

unzip CZ9XJML.zip

A directory named disk1 will be created. 

Obtain Licenses
In this section, the user navigates to the licensing page on the active and standby nodes, determines the 
MAC addresses of the nodes, and then uses them to generate licenses.

The Rational licensing page is found at the following URL. 
https://licensing.subscribenet.com/control/ibmr/login. 

3. Open a web browser and navigate to the Rational licensing page.

Follow the links to Rational License Key Center and then click Continue.

Page 13 of 85      http://www.ibm.com/support/techdocs – WP101738

© International Business Machines Corporation 2010

http://www.ibm.com/support/techdocs
https://licensing.subscribenet.com/control/ibmr/login


4. Enter your ID and password to log in. 

Navigate to the link for Rational ClearCase. 

On the “My License Keys” page, select IBM Rational ClearCase Floating License Key 
(Classic ClearCase license manager)

5. The “Select License Key” page loads. 

Choose the appropriate license and click Next.

6. The “Quantities and Host Information” page loads.

This page provides tools to determine the MAC addresses of the nodes, however those 
provided for Linux do not operate on the zLinux architecture. 

7. Determine the MAC Address
On the active node, in a terminal window enter the following command.
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ifconfig | grep Hwaddr

Make note of the address after HWaddr. In this case, 

00:06:29:9C:84:40

8. Return to the “Quantities and Host Information” page on the licensing web site.

“Number of Keys to generate”           100

Primary Host
HostID             MAC address of the active node 

Hostname         Hostname of the active node
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Click Generate.

9. On the next page, the license is displayed. 

Click the Download License Keys button. 

Save the file for when it is needed in the installation process.

10. Repeat the same steps for the standby node.

Active Node
  
This section installs the ClearCase server on the active node.

Version 7.1.1.1 is required for SLES 10 SP3

Prepare the Operating System

1. Update the file limits for the server. 

For best results the number of file handles available to the system must be increased. 
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Edit file /etc/security/limits.conf
Add the following 2 lines

* soft nofile 4096
* hard nofile 4096
Log out and log back in for these limits to take effect. 

Enter the command ulimit -a and verify the max number of open files is 4096.

2. Create the ClearCase user group and admin user. 
groupadd ccgroup

useradd –G ccgroup ccadmin 

Set the password for ccadmin
passwd ccadmin

Enter a password when prompted.

3. ClearCase requires the 32bit library of libstdc++.

Use YaST to install libstdc++33-32bit 

Install ClearCase

1. The Installation Manager is used to install the ClearCase server.

Navigate to /RCC/disk1 and start the install with launchpad.sh.

The launchpad welcome page loads. Select Install IBM Rational ClearCase v7.1.1

2. The Installation Manager loads to the “select packages” page. There may be more recent 
versions available. Installation Manager can check and install them.
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Check the box Show all versions and select Check for other versions and extensions.

3. The results indicate that Version 7.1.1.1 and Rational ClearCase is available, but Installation 
Manager 1.3.4 is required first.

Begin by installing Installation Manager 1.3.4

Select Next.

4. Follow the instructions on the screens to install Installation Manager V1.3.3.

Upon completion, select Restart Installation Manager.

5. Upgrade Installation Manager
When the Installation Manager reloads, select File -> Preferences ->  Updates. 
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Check the box for Search for Installation Manager Updates.
Select  OK. 
On the Installation Manager welcome page, select Install.
Installation Manager will now check for updates and prompt the user that a new version is 
available. Select  OK to install Installation manager V1.3.4

Upon completion, select  OK to restart the Installation Manager. 

6. The Installation Manager must be launched from the ClearCase launchpad. Close the running 
instance of Installation Manager. 

On the launchpad welcome screen, that should still be running, select Install IBM Rational 
ClearCase v7.1.1.

7. The Installation Manager loads to the "select packages" page. 

Check the box Show all versions and select Check for other versions and extensions.

8. The package screen indicates that version 7.1.1.1 is available. 

Verify that it is selected and click Next. 

9. The installation screens are displayed.

    To Continue, accept the licenses.

    Indicate a path for shared Installation Manager resources.

    Create a new package group.

    Select required languages.

    Select ClearCase Full Function Installation. 

    Accept the default for the temporary directory. 
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    Registry server: Enter the IP address for the active node.

    Unix Registry Region: A unique name such as zlinux

    Choose to rebuild the MVS module. Select the path to the kernel src, such as 
/usr/src/linux-2.6.16.60-0.54.5-obj/s390/default

    Select “Atria Licensing”. 

    Choose “On my local host” and enter your ClearCase license for the active  node. 

10. On the summary screen, select Install. 
This can take several minutes to complete. 

Upon completion, click Finish.

11. Close the launchpad screen.

12. Make the commonly used ClearCase commands available to users.
ln -s /opt/rational/clearcase/bin/cleartool /usr/bin/

ln -s /opt/rational/clearcase/bin/clearlicense /usr/bin

ln -s /opt/rational/clearcase/etc/clearcase /usr/bin

13. Configure ClearCase to be a registry server.

Create the file /var/adm/rational/clearcase/config/rgy_svr.conf  and enter the string 
master.
Stop and start ClearCase.
Clearcase stop

clearcase start

14. Set the registry password.
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/opt/rational/clearcase/etc/rgy_passwd

Enter a password when prompted.

The active node now has the ClearCase infrastructure installed and ready to use. 

Samba (Use Case 1 only)
Samba is an Open Source suite that provides file and print services to SMB/CIFS clients.  Samba 
allows for interoperability between Linux/Unix servers and Windows-based clients. To expose locally 
mounted disks on the Linux Server image to ClearCase Windows clients SAMBA is required.  If 
SoNAS or other NAS device is used this is not required as NAS devices support CIF,  thus clients can 
connect directly to device 

For a Windows workstation to have acess to the ClearCase infrastructure running on Linux on System 
z, the server must have Samba installed and configured. 

This section installs and configures Samba on the ClearCase server. 

Install Samba

1. The Samba infrastructure is installed using the standard Linux distribution utilities. 

On SLES, enter yast2 in the terminal. 

2. The YaST Control Center launches. 

Select Software in the left hand menu pane, and then Software Management. 

3. The Software Management screen is displayed.
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Use the Search box to search for “samba”.

4. The package screen is populated with samba related packages. 
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Install samba, samba-32bit, samba-client, and samba-doc.

5. Upon successful completion, close YaST.

6. Configure the samba service to start automatically.
chkconfig smb on

chkconfig nmb on

7. Start the samba related services.
rcsmb start

rcnmb start

Samba Web Administration Tool
The Samba Web Administration Tool (SWAT), provides a Web accessible configuration tool. It must be 
configured before it is available for use. 

Enable SWAT

1. Edit file /etc/xinetd.d/swat giving the disable parameter a value of  no.
Comment out the line only_from with a # to allow access from other machines. 

Save and close the file. 

2. The xinetd service needs to be restarted to take effect.
/etc/init.d/xinetd stop

/etc/init.d/xinetd start

3. On the node, use a web browser to navigate to http://localhost:901
A screen prompting for User Name and Password is displayed. 
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Enter the root id and password.

4. The SWAT home page loads.

Configure the server
This section uses the SWAT interface to configure the Samba server.

1. On the SWAT home page, select the link for Globals.
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This page provides an interface to the global samba parameters located in smb.conf. 

2. No changes are necessary at this point. Make note of the workgroup name, WORKGROUP, 
that will need to match the Windows workstations that connect to this server. 

3. Switch to the Advanced page by selecting the Advanced button at the top of the page.

Locate the username map field and enter /etc/samba/username.map.

Select Commit Changes at the top of the page.

4. Select the SHARES tab on the top menu.
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This page allows for the creation of the shares that will be made available by the Samba 
server.

5. Configure Samba to share the parent directory of the views and VOBs data directories.

Create a share named IMShared. 

Give a path named /opt/ibm/IMShared
Change read only to No.
Set hosts allow to all.
Change guest ok to Yes. 

Select Commit Changes.

6. Verify the values  by selecting IMShared and selecting Choose Share.

Close the web browser. 

7. Some manual configuration is required.

In a terminal window open /etc/samba/smb.conf for editing. 
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Locate the share for IMShared.

If available = No for this file, change it to available = Yes.

Save and Close the file.

Configure the Samba Users

1. The username map file that was configured must be created and populated.

In a terminal window, create the file.
touch /etc/samba/username.map

Populate the file with the following string.
ccadmin = ccadmin

2. Configure ccadmin as a Samba user.
smbpasswd -a ccadmin

When prompted, enter a password.

Enable the ccadmin user.
smbpasswd -e ccadmin

3. Restart the services.
rcsmb restart

rcnmb restart

The server is now configured to share files through Samba.

NFS (Use Case 1 only)
Network File System (NFS) is a file and directory sharing mechanism native to Unix and Linux. It will 
be used by Linux ClearCase workstations to mount the shared views and VOBs. To expose locally 
mounted disks on the Linux Server image to ClearCase Linux clients NFS is required.  If SoNAS or 
another NAS device is used this is not required as NAS devices support NFS, thus clients can connect 
directly to device 
 
NFS should be installed on SuSE  servers by default. This section steps through the proeedure for 
configuring  NFS.

1. Setting up the NFS share requires only to modify a file.
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Edit file /etc/exports to share the parent directory of the views and VOBs data.

Enter the following:
/opt/ibm/IMShared *(rw,sync,insecure,root_squash,no_subtree_check,fsid=0)

This statement shares the directory, allows all subnets to connect to it, and provides some key 
parameters

Save and close the file.

2. NFS on SLES uses the nfsserver service to control the server. Start the server and enable it to 
star automatically.
service idmapd start

rcnfsserver start

chkconfig nfsserver on

The NFS server is now started and ready to receive client connections.

Standby Node
The purpose of the standby node is to be identical to the active node. When the system fails over, it 
must appear to attached clients as if nothing has changed. This document will not reproduce the steps 
already described in the active node and samba server sections, though they must be repeated for the 
standby node. This section identifies standby node considerations.

1. The standby node must have access to the shared disk used to store the VOB, view, and 
registry information. If using local ECKD disks which are activated during installation of the 
operating system, the node will be attached at first log hin. Un-mount the shared disk when 
first accessing the standby node.

2. Separate licensing must be obtained for the standby node. The licenses are dependent on the 
MAC addresses of the nodes. If it has not already been done, acquire the license for the 
standby node. 

3. The registry server on the standby node is the standby node itself. Enter it's IP when prompted 
during installation, such as 9.82.24.174.

4. The standby node requires the same IP connectivity as the active node. Verify the /etc/hosts 
file has the same hosts file setup as the active node, containing the IP's for both nodes and the 
service address.  

5. When setting the registry password, set the same one as on the active node. 

6. The Samba server's configuration must be identical to the active node's. 

7. The NFS server's configuration must be identical to the active node's. 
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The standby node is now configured to be identical to the active node. It will be configured to take over 
the ClearCase artifacts in a later chapter.
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Chapter 3 Configure ClearCase for HA
The seamless failover between ClearCase nodes requires the ClearCase data to be accessible from both 
nodes. The registry, views, and VOBs  must be located on shared storage that is mountable to each 
node. 

The POC system uses a root shared directory of /opt/ibm/IMShared where the ClearCase data file 
system is located. The shared directory can either be locally mounted native storage ECKD/FCP or a 
networked attached storage device.   This section provides instructions and considerations for moving 
the data to a the shared storage. 

This section is for the Active Node.  The Standby Node will be configured in Chapter 5.

Shared Storage Directory

If it is not mounted already the shared file system needs to be mounted to /opt/ibm/IMShared directory. 

The mount point should be defined in file /etc/fstab, it must have the noauto parameter set. 
Automation will control the mount point and it must not be mounted automatically by the operating 
system.

The following is the statement from the POC systems /etc/fstab file.
/dev/ccvg/cclv  /opt/ibm/IMShared       ext3    noauto 0 0

To confirm the shared directory is mounted  use the df -h command.  The shared directory should be 
listed:
/dev/mapper/ccvg-cclv                      115G  327M  109G   1% /opt/ibm/IMShared

ECKD Local Storage (Use Case 1)

An example of mounting ECKD disks is to issue the mount command with the partition name 
of the logical volume with the defined shared mount point.
mount /dev/ccvg/cclv /opt/ibm/IMSHARED

NAS Storag (Use Case 2)

An example of mounting a NAS device is to issue the mount command to the NFS server 
hosted on the device. The mount command specifies the type,the address, the location of the 
share, and the local mount point
mount -t nfs 
sonas.stordemo.wsclab.washington.ibm.com:/ibm/gpfs0/citigrp1 
/opt/ibm/IMSHARED
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Registry
This section moves the Registry data to the shared drive. 

1. Stop the ClearCase server.
/opt/rational/clearcase/etc/clearcase stop

The command provides feedback similar to:
Unmounting VOBs... 

2. Copy the  rgy directory to the shared file system.
cp -rp /var/adm/rational/clearcase/rgy /opt/ibm/IMShared

3. Rename the old registry directory
mv /var/adm/rational/clearcase/rgy   

                              /var/adm/rational/clearcase/rgy.old
4. Create a symbolic link from the local clearcase dir to the shared registry.

ln -s /opt/ibm/IMShared/rgy /var/adm/rational/clearcase/rgy

Service Hostname and IP
The HA environment requires a service hostname and IP address to be used on the active ClearCase 
server. These values will be used by clients to connect to whichever server is running, making the 
connection to the backend seamless to the user. All of the version controlled objects created within 
ClearCase will be identified with this service information and not the configured hostname and IP of 
the server.

This section configures the node to identify itself with the service hostname and IP. 

1. Assign the node an alias IP matching the service IP. 

For configuration purposes, the objects need to be defined with the service IP. Do not have the 
operating system assign this service IP alias automatically. TSA will  be configured to control 
the assignment of the service IP.
ifconfig eth0:1 9.82.24.170 netmask 255.255.255.0 up

Add service IP to /etc/host file if it is not registered to DNS
9.82.24.170     soncc1.washington.ibm.com soncc1

2. Verify the connectivity with the service IP address by pinging the service hostname as it is 
defined in the /etc/hosts file.
ping soncc1

The feedback provided should show successful communication.

3. The ClearCase server can now define the service hostname as an acceptable alternative. 
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Create file /var/adm/rational/clearcase/config/alternate_hostnames.

Give it the contents of the service hostname, soncc1.washington.ibm.com.
sonnf2:~ # cat /var/adm/rational/clearcase/config/alternate_hostnames 

soncc1.washington.ibm.com 

sonnf2:~ # 

4. ClearCase is now configured to have objects created with the service IP.

Start ClearCase.
clearcase start

VOB
A version object base is the permanent data repository in which files, directories, and metadata is 
stored. In an HA environment, the VOB must be associated with the service hostname and IP  that will 
be shared between nodes.

The elements created under version control must be done as the ccadmin not the root user. This will 
allow the ccadmin user from other platforms to access the VOB.

1. Switch to the ClearCase admin user.
su - ccadmin

2. Verify registry connectivity. 
cleartool lsregion

The command should respond with
zlinux

3. Create a VOB associated with the service hostname, sonnc1, and located on the shared storage 
mount point.  . The following command is one line.
cleartool mkvob -tag /vobs/eckd1_vob_vobs -nc -public -host 
soncc1.washington.ibm.com -hpath /opt/ibm/IMShared/eckd1_vob_vobs -gpath 
/opt/ibm/IMShared/eckd1_vob_vobs /opt/ibm/IMShared/eckd1_vob_vobs

Enter the registry password when prompted.

The command should provide feedback similar to:
Registry password: 
Created versioned object base. 
Host-local path: soncc1.washington.ibm.com:/opt/ibm/IMShared/eckd1_vob_vobs 
Global path:     /opt/ibm/IMShared/eckd1_vob_vobs 
VOB ownership: 
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  owner /ccadmin 
  group /users 
Additional groups: 

  group /ccgroup 
4. Mount the new VOB. 

cleartool mount -all 

View VOB details
cleartool lsvob 

Provides the following:
* /vobs/eckd1_vob_vobs /opt/ibm/IMShared/eckd1_vob_vobs public 

5. View the VOB in more detail.
cleartool describe vob:/vobs/eckd1_vob_vobs

The following is provided:
versioned object base "/vobs/eckd1_vob_vobs"

  created 2010-05-18T15:02:54-04:00 by root.root@sonnf1
  VOB family feature level: 5
  VOB storage host:pathname 
"soncc1.washington.ibm.com:/opt/ibm/IMShared/eckd1_vob_vobs"

  VOB storage global pathname "/opt/ibm/IMShared/eckd1_vob_vobs"
  database schema version: 54
  modification by remote privileged user: allowed
  atomic checkin: disabled
  VOB ownership:
    owner /ccadmin
    group /ccgroup
  Attributes:
    FeatureLevel = 5

6. If you are having trouble running checkin and checkout out of files that belong to other users 
or adding new files to the ClearCase source control cleartool protect and cleartool protectvob 
might be needed. 

protectvob (cleartool subcommand, run as "cleartool protectvob")
The protectvob command manages the ownership and group membership of the files and 
directories in a VOB, by changing the OS-level permissions on files and directories within the 
VOB storage area.

Common scenarios: Adding, removing or changing a group to the VOB's group list; changing 
the VOB owner. 

protect (cleartool subcommand, run as "cleartool protect")
The protect command sets the owner, group, or permissions for elements, shared derived 
objects, or VOB objects which are maintained in the VOB database.
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The main use of protect is to control access by standard programs to an element or object's 
data. For example, elements can be made readable by anyone and make others readable by 
only their group members.

Common scenarios: Changing an element's owner; changing the group on a derived object; 
changing the group on a branch, label or other metadata; adding or removing the r-w-x 
permissions for an element.

cleartool protectvob –chown ccadmin –chgrp ccgroup /vobs/eckd1_vob
cleartool protect –chown ccadmin –chgrp ccgroup -recurse /vobs/eckd1_vob 

View
Views provide several important functions: 

• Access to VOB data 
• Workspaces where users can modify VOB data 
• Short-term storage for other data created during the development process 

A typical view contains a combination of versioned artifacts (versions of VOB elements) and 
unversioned artifacts (view-private files that do not exist in any VOB).

This POC uses Dynamic views. Dynamic views provide transparent access to versions of elements in 
the VOB and to view-private objects. A dynamic view can access any version of an element selected by 
the view's config spec as soon as the version is checked in. 

The view must be created in association with the service hostname and IP.

1. Continuing as ccadmin, create a view that will be used by attached workstations.

Make a parent directory for the views
mkdir /opt/ibm/IMShared/view_store

Enter the following command as one line. 
cleartool mkview -tag ccadmin_view_sonas_shrd -host 
soncc1.washington.ibm.com -hpath 
/opt/ibm/IMShared/view_store/ccadmin_view_sonas_shrd -gpath 
/opt/ibm/IMShared/view_store/ccadmin_view_sonas_shrd 
/opt/ibm/IMShared/view_store/ccadmin_view_sonas_shrd

The command will provide feedback similar to:
Created view. 
Host-local path: 
sonc11.washington.ibm.com:/opt/ibm/IMShared/view_store/ccadmin_view_sonas_s
hrd 
Global path:     /opt/ibm/IMShared/view_store/ccadmin_view_sonas_shrd 
It has the following rights: 
User : ccadmin  : rwx 
Group: users    : r-x 
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Other:          : r-x 

2. Verify the view details.
cleartool lsview -long

The command will provide details similar to:
Tag: ccadmin_view_shrd

  Global path: /opt/ibm/IMShared/view_store/ccadmin_view_shrd
  Server host: soncc1.washington.ibm.com
  Region: zlinux
  Active: NO
  View tag uuid:ef96287f.644411df.863f.02:00:00:00:00:14
View on host: soncc1.washington.ibm.com
View server access path: /opt/ibm/IMShared/view_store/ccadmin_view_shrd
View uuid: ef96287f.644411df.863f.02:00:00:00:00:14
View owner: /ccadmin

Region
The Windows workstations will belong to an additional region. It must be created on the server.

1. Create the windows region. 
cleartool mkregion -tag windows

2. Verify the regions.
cleartool lsregion

The output should display:
windows

zlinux

The ClearCase server is now configured and has objects that can be used by a client. The next chapter 
discusses the installation, configuration, and use of a ClearCase workstation using the configured 
server. 
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Chapter 4 Configuring a Local client on Workstation

Windows Workstation
For Windows workstations, Rational ClearCase depends on a Windows domain controller to 
synchronize passwords between the workstations and servers. The access permissions of the files are 
maintained across all the machines using the visioned repository. . The POC environment did not have 
a domain controller  available, making it necessary to manually synchronize user ids and passwords on 
the host, within samba, and on the workstation.

Create the Common ClearCase Admin User
1. On the Windows workstation, log in as a user with administrative rights. 

Browse to Start → Control Panel → User Accounts → Create a new account.

2. Follow the instructions on the screen to create a user named ccadmin.

3. When the user screen reloads, select the newly created user. The “User Accounts” screen 
loads.

Select Change the password.

4. On the password screen, enter the same password used for ccadmin on the Linux ClearCase 
server. 

5. Close the user account screens. ccadmin will now be added to the ccgroup group.

From the Control Panel, navigate to Performance and Maintenance → Administrative 
Tools  and open computer management.
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6. Browse to System Tools -> Local Users and Groups -> Groups.

Right click the background of the main window pain and choose New Group.

7. In the pop up window, give the group the name of ccgroup and add ccadmin as a member.

Click Create.

8. Close the group page and the Computer Management screen.

9. On windows, the primary group is specified when the user's domain account is created. If the 
user is a member of multiple groups, a user environment variable must be set.

Browse to Start → Control Panel → Performance and Maintenance → System.

10. Select the Advanced tab and then the Environment Variables button.

Under the System Variables section, click New.
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11. In the pop-up window, enter the following values.

Variable name: CLEARCASE_PRIMARY_GROUP
Variable value: ccgroup
Click OK on this window, the Environment Variables Window, and the System Window.

This environment variable will now be set for all users when they log in. 

Establish Connectivity
In the POC environment, the machines' IP addresses were not stored in the DNS. The hosts files must 
be modified to allow them to refer to each other by name.

1. Edit the hosts file.

Open the file at C:\WINDOWS\system32\drivers\etc\hosts in wordpad.

2. Add entries for the two ClearCase nodes and the service address, for example: 
9.82.24.170     soncc1.washington.ibm.com soncc1

9.82.24.173     sonnf1.washington.ibm.com sonnf1

9.82.24.174     sonnf2.washington.ibm.com sonnf2

9.82.35.51      sonas.stordemo.wsclab.washington.ibm.com sonas

3. Save and close the file. 

4. Verify connectivity . Open a command prompt window and enter the following command.
ping soncc1

The response should indicate replies from the server. 

Ctl + c to stop the ping.

Verify Samba Connectivity (Use Case 1)
This section verifies the workstations ability to map to the shared Samba file system on the Linux 
server. Establish this type of connection when using server locally mounted ECKD or FCP shared 
storage as in Use Case 1.   The current Windows user is an administrator and is required to install 
ClearCase. This user is not mapped to the Samba share. It will be able to see the available files but not 
access them. In a later section, the workstation will be switched to the ccadmin user and then a full 
access test can be performed. This section is for a quick verification.

1. In the Windows Explorer address bar, enter the address for the samba share.

\\soncc1

Page 38 of 85      http://www.ibm.com/support/techdocs – WP101738

© International Business Machines Corporation 2010

http://www.ibm.com/support/techdocs


The window should connect and show the shares setup early. 

Verify SoNAS Connectivity (Use Case 2)
This section verifies the workstation ability to map to the shared SoNAS file system on the NAS 
device. Establish this type of connection when implementing Use Case 2 NAS shared storage. Both the 
Linux server and workstation are connecting to the same shared storage.  To test 

1. In the Windows Explorer address bar, enter the address for the samba share.

\\sonas.stordemo.wsclab.washington.ibm.com  or \\sonas
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Note NAS device might prompt you for a domainname\userid and password.   As discussed 
previously the NAS device should be connected to the same domain controller.  In our case 
we had to define ccadmin within the NAS device as a domain controller was not available. 

Install Rational ClearCase on Workstation
This section installs Rational ClearCase on the Windows workstation. 

1. Browse to the location of the installation media.

In the case of the POC, it is located at

 C:\Documents and Settings\Administrator\My 
Documents\Downloads/CZ9WAML\disk1

2. Invoke the launchpad command launchpad.exe.

3. The welcome screen is displayed.
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Click the link to “Install IBM Rational ClearCase V7.1.1.

4. The IM loads the “Install Packages” page showing Installation Manager Version 1.3.3 and 
ClearCase Version 7.1.1.

Check for more recent versions by checking the box for Show all Versions and selecting the 
Check for Other Versions and Extensions button.

5. The screen refreshes with the current versions of the packages. 

The screen indicates the newest version of ClearCase requires an upgrade of the IM.

6. Select the box for ClearCase version 7.1.1.02.

A window indicates that IM will be upgraded first. 
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Click Continue.

7. Follow the instructions on the screen to install IM.

After selecting the Install button, the process takes a few minutes.

8. Upon successful completion of the installation click Restart Installation Manager.

9. The IM relaunches and displays the “Install Packages” page.

Check the box for Show all Versions and selecting the Check for Other Versions and 
Extensions button.

Verify the box for version 7.1.1.02 is checked and click Next.

10. Follow any directions on the Prerequisite page.

Accept licenses to continue. 

Accept the default installation directories. 

Choose required languages.

The Windows installation offers client infrastructure for accessing Views and VOBs on other 
hosts. Choose Dynamic views and Local Views and VOBs.

11. Leave Common Licensing blank. This install uses atria licensing. 

12. ClearCase will run as a service, and requires user information.

Use the ccadmin and ccgroup user and group set up in a previous step.

13. On the register server screen inter the service name soncc1.washington.ibm.com for the 
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registry server.

The Windows registry region is windows.

The UNIX registry region is zlinux.

14. Disable the remote administration for ClearCase.

Have MVFS Case Sensitivity  not be case sensitive, and configure it to preserve the case.

Accept the defaults for MVFS Settings.

Disable CCFS.

Do not specify a pop-up menu.

Do not specify tool shortcuts.

15. ClearCase Atria Licensing, check the box to use Atria. 

Check the bos for On a remote host. 
Enter the full service address, such as

soncc1.washington.ibm.com
Click Next.

16. The summary screen is displayed.

Click Install.
The installation process takes a few minutes.

17. The success screen indicates a Restart is required.
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Select Restart Now and click Finish.

Configure Rational ClearCase on Workstation
The configuration of ClearCase must be done the ClearCase admin user, ccadmin.

1. Log into the workstation as the ClearCase admin, ccadmin.

2. Verify Samba connectivity. 

This user needs to have authority to mount the shared Samba directories on the Linux server. 

Open Windows Explorer and enter the machine path name of the server, such as \\soncc1
The connection may prompt for a username and password. Use ccadmin. If connectivity does 
not work, revisit the Samba setup section. 

3. Verify primary group.

Open a Command Prompt from the Start menu.

Enter the following command:

“c:\Program Files\IBM\RationalSDLC\ClearCase\etc\utils\creds”

The results should be similar to the following, indicating ccgroup is the primary group.

4. Invoke the ClearCase configuration windows.

Navigate to Start → All Programs → IBM Rational ClearCase → Home Base.

From the Home Base screen, select the Administration tab and then Control Panel.
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5. On the Control Panel, select the Options tab. 

Verify the options. The setup should not be using CCFS and the Domain name should be the 
same as what was setup on the Samba server.

Make any necessary changes and select OK. 
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Import Host VOB and View
This section verifies registry configuration and imports the existing artifacts to the workstation. 
1. Return to the ClearCase Home Base window on the Administration tab.

Select Region Synchronizer.

2. Select the View Tags, and then the proper view out of the list.

Click Import.
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3. A warning will be displayed that the Global Path must be set. The default is the location on 
the Linux host. Change it to the proper path from the Samba share or the network attached 
storage.

Select OK.
4. On the Synchronize screen, select VOB tags.

Select the the proper VOB, /vobs/eckd1_vob, and click Import.
5. A warning is given that the Global Path must be set. The default is the location on the Linux 

host. Provide the path from the Samba share or the network attached storage.

In the password field, enter the registry password that was configured on the host.
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Click OK. Close the Synchronize window.

Use the VOB and View

1. From Home Base, select the VOBs  tab and click Mount.  

2. In the pop-up window, select the VOB and click Mount.

3. Start the view.
Select the Views tab on the Home Base.
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Select Start View.
4. In the pop-up window, select the view.

Accept the default mapped drive, Z:.
Click  OK.

5. Access the view by using Windows Explorer to access drive Z or the view mounted on M. 
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Linux Workstation
For Linux workstations, Rational ClearCase depends on Network Information System (NIS). Using 
NIS, each host client or server computer in the system has knowledge about the entire system. A user at 
any host can get access to files or applications on any host in the network with a single user 
identification and password. The files under version control maintain the ownership permissions 
defined by the OS. NIS allows the user to be identical on each machine without further administration 
duties. 

The POC environment is not using NIS. To maintain user compliance, the users and groups defined on 
the Linux workstation must have the same ID's as those defined on the ClearCase server. It is also 
necessary to manually synchronize the passwords. 

Create the Common ClearCase Admin User

1. Verify the ID's of the user and group on the active node. This requires looking into specific 
system files.

Search for the groupid for ccgroup with the following command:
grep ccgroup /etc/group

This will provide a response similar to
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ccgroup:!:1000:ccadmin 

This indicates the groupid is 1000.

2. Search for the uid for ccadmin with the following command:
grep ccadmin /etc/passwd

This will provice a response similar to
ccadmin:x:1001:100::/home/ccadmin:/bin/bash 

This indicates the uid is 1001.

3. On the Linux workstation, log in as the root user. 

4. Open a terminal window by right clicking the background and selecting Open Terminal.

5. Create the group using the same groupid as the server.
groupadd -g 1000 ccgroup

6. Create the user using the same uid as the server.
useradd -u 1001 -g ccgroup ccadmin

7. Set the ccadmin password.
passwd ccadmin

When prompted for a password, enter the same one used on the ClearCase server.

Establish Connectivity
In the POC environment, the machine's IP addresses are not stored in the DNS. The hosts files must be 
modified to allow them to refer to each other by name.

1. Edit the hosts file.

Open file /etc/hosts for editing, using VI or gedit, for example.

2. Add entries for the two ClearCase nodes and the service address for example:
9.82.24.170     soncc1.washington.ibm.com soncc1

9.82.24.173     sonnf1.washington.ibm.com sonnf1

9.82.24.174     sonnf2.washington.ibm.com sonnf2

9.82.35.51      sonas.stordemo.wsclab.washington.ibm.com sonas

Save and close the file.

3. Verify connectivity. In the terminal window, ping the service hostname.
ping soncc1
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The response should indicate replies from the server

Ctl + c to stop the ping.

Verify NFS Connectivity (Use Case 1)
This section verifies the Linux workstations ability to mount the NFS shared directory on the server.

1. Create the mount points.
mkdir -p /opt/ibm/IMShared

mkdir -p /vobs/eckd1_vob_vobs

2. Mount the shared NFS directory using the service address.
mount -t nfs -w soncc1.washington.ibm.com:/opt/IBM/IMShared 
/opt/ibm/IMShared

3. View the contents of the shared directory.
ls -al /opt/ibm/IMShared

The contents of the directory should be displayed. 

Verify NFS Connectivity (Use Case 2)
This section verifies the Linux workstations ability to mount the NFS  shared directory on the SoNAS 
device.

1. Create the mount points.
mkdir -p /opt/ibm/IMShared

mkdir -p /vobs/sonas_vob

2. Mount the shared NFS directory using the service address.

mount -t nfs sonas.stordemo.wsclab.washington.ibm.com:/opt/IBM/IMShared 
/opt/ibm/IMShared

3. View the contents of the shared directory.
ls -al /opt/ibm/IMShared

The contents of the directory should be displayed. 
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Install Rational ClearCase on Workstation
This section installs Rational ClearCase on the Linux workstation.

1. Browse to the location of the installation media.

In the case of the POC, it is located at 
cd /installs/cc/disk1

2. Invoke the launchpad command launchpad.sh.

3. The welcome screen is displayed.

Click the link to “Install IBM Rational ClearCasae V7.1.1.

4. The IM loads the “Install Packages” page showing Installation Manager Version 1.3.3 and 
ClearCase Version 7.1.1

Check for more recent versions by checking the box for Show all Versions and selecting the 
Check for Other Versions and Extensions buttons.

5. The screen refreshes with current versions of the packages. 
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The screen indicates the newest version of ClearCase requires an upgrade of the IM.

6. Select the box for the current version of ClearCase.

A pop-up window indicates that IM will be upgraded first.

Click Continue.

7. Follow the instructions on the screen to install IM.

After selecting the Install button, the process takes a few minutes.

8. Upon successful completion of the installation click Restart Installation Manager. 

9. The IM launches and displays the “Install Packages” page. 

Check the box for Show all Versions and selecting the Check for Other Versions and 
Extensions button. 

Verify the box for the latest version (7.1.1.02 at the time of writing this document) is checked 
and click Next.

10. Follow any directions on the Prerequisite page.

Accept licenses to continue.

Change the installation directory from /opt/ibm/IMShared to /opt/ibm/IMShared2
Choose required languages.

Choose to install the Full Function option.
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11. Leave Common Licensing blank. This install uses atria licensing.

For the registry server, enter the service name soncc1.washington.ibm.com.

Enter the region as zlinux. 

12. Continuing on the MVFS module screen, choose to rebuild the MVS module. 

Select a path to the kernel source such as /usr/src/kernels/2.6.180164.el5-1686

13. For Atria licensing, check the box to use Atria. 

Check the box for On a remote host.
Enter the full service address, such as

soncc1.washington.ibm.com
Click Next.

14. The summary screen is displayed. 
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Click Install.
The installation process takes a few minutes.

15. Once the success screen is displayed click Finish. 

Close the launchpad.

16. Make the base commands available to all users by creating links to the /usr/bin directory.
ln -s /opt/ibm/RationaloSDLC/clearcase/etc/clearcase /usr/bin

ln -s /opt/ibm/RationaloSDLC/clearcase/bin/cleartool /usr/bin

ln -s /opt/ibm/RationaloSDLC/clearcase/bin/clearlicense /usr/bin

Configure Rational ClearCase on Workstation
The configuration of the ClearCase must be performed as the ClearCase admin user, ccadmin.

1. Switch to the ccadmin user.
su - ccadmin

2. Verify connectivity to the license server.
clearlicense

Output similar to the following should be displayed.
Licensing information for ClearCase. 
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License server on host "soncc1.washington.ibm.com". 

Running since Mon 19 Jul 2010 04:10:10 PM EDT. 

LICENSES: 

     Max-Users  Expires       Password [status] 
       100    01/15/2011      4c35e6a1.662f4c13.02 [Valid] 

 Maximum active users allowed: 100 
 Current active users: 0 
 Available licenses: 100 

License Usage Statistics: 

0 licenses revoked since start of period 08/05/2010. 

0 license requests denied. 

0 active users bumped by preferred user. 

3. Verify connectivity to the registry server by displaying the region.
cleartool lsregion

The output should display the two defined regions.
zlinux

windows

4. View the defined VOBs.
cleartool lsvob

The output should display the defined VOBs.
* /vobs/eckd1_vob_vobs /opt/ibm/IMShared/eckd1_vob_vobs public 

5. View the defined views.
cleartool lsview

The output sould display the defined views.
ccadmin_view_sonas_shrd     

        /opt/ibm/IMShared/view_store/ccadmin_view_sonas_shrd 

6. Verify the VOB is mounted.
cleartool mount /vobs/eckd1_vob_vobs

7. Set the active view.
cleartool setview ccadmin_view_shrd
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Files can now be added to control and accessed at /vobs/eckd1_vob_vobs.
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Chapter 5 ClearCase Failover 
At this point in the document, there is an active node and a standby node configured with ClearCase 
servers. The active node is assigned the service IP and has the shared data mounted to local directories. 
There are two clients configured to use the active node, accessing the service IP. 

Manual Failover
This section goes through the manual process of failing over to the standby node. In the next section, 
this process will be automated.

Shutdown the Active Node
This section is performed on the active node.
1. Stop ClearCase.

clearcase stop

Feedback similar to the following should be displayed.
Unmounting VOBs... 

2. Stop Samba and NFS servers.
rcsmb stop

rcnmb stop

rcnfsserver stop

3. Force the shared disks to unmount.
umount -f /dev/ccvg/cclv

4. Remove the service IP alias.
ifconfig eth0:1 down

Setup the Standby Node for HA
The standby node has not been setup to use shared drives, as the active node has. The first time the 
node is failed over, this must be configured.

This section is performed on the standby node.
1. Verify ClearCase is stopped.

clearcase stop

2. Mount the shared disks.

Use Case 1 with local shared storage
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mount /dev/ccvg/cclv /opt/ibm/IMShared

or

Use Case 2 with SoNAS Network Atttached Shared Storage
mount -t nfs 
sonas.stordemo.wsclab.washington.ibm.com:/opt/ibm/IMShared 
/opt/ibm/IMShared

3. Remove the registry information for this node and replace it with the existing registry data on 
the shared drive.
mv /var/adm/rational/clearcase/rgy   

   /var/adm/rational/clearcase/rgy.old
ln -s /opt/ibm/IMShared/rgy /var/adm/rational/clearcase/rgy

4. Assign the service IP as an alias IP to the node.
ifconfig eth0:1 9.82.24.170 netmask 255.255.255.0 up

5. Assign an alternate host name for the service IP.

Create file /var/adm/rational/clearcase/config/alternate_hostnames.

Give it the contents of the service hostname, soncc1.washington.ibm.com.

6. Restart the Samba and NFS servers. (Only for Use Case 1)
rcsmb restart

rcnmb restart

rcnfsserver restart

7. Start ClearCase.

clearcase start

Verify ClearCase
This section verifies the failover to the standby node. 

1. Switch to the ClearCase admin user.
su - ccadmin

2. Check the license server.
clearlicense

The output should match the license information seen in previous steps.

3. Verify the VOBs.

cleartool lsvob
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The output should indicate the VOBs are mounted

4. Verify the views.

cleartool lsview

The output should show the views defined previously

5. Set the view.
cleartool setview ccadmin_view_shrd

6. View the contents of VOB.
ls  /vobs/eckd1_vob_vobs

The contents should be displayed.

Verify the Clients
This section verifies the connectivity with the clients. The failover should have been seamless to the 
clients. 

Windows Client
The client is already configured and connected to the server. The verification test can be as simple as 
viewing the contents of the VOB through the view.

1. Verify connectivity to the view.

In “Windows Explorer”, browse to the mapped drive for the view at ccadmin_view_shrd on 
'view' (Z:).
This may take a moment to establish a connection, but the contents of the view will be 
displayed.

Linux Client
The client is already configured and connected to the server. The verification test can be as simple as 
viewing the contents of the VOB through the view.

1. Verify the contents of the VOB.
ls -al /vobs/eckd1_vob_vobs

This may take a moment to establish a connection, but the contents of the VOB will be 
displayed.
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Chapter 6 Install and configure TSA for Multiplatforms 
The manual failover procedure identified four items:
• Stop and start ClearCase
• Stop and start Samba and NFS (Use Case 1 only)
• Unmount and mount the shared drive
• Assign the service IP alias

Tivoli System Automation for Multiplatforms (TSAMP) will be used to control these processes. It will 
detect when the active node has gone down and will perform the procedure described in the previous 
section.

Install TSA for Multiplatforms
TSA must be installed on each node. It will monitor when the active node, ClearCase process, IP or 
storage become unavailable and then failover to the standby node. Reverting the resources back to the 
active node will not happen automatically by TSA to avoid undesired system behavior. If needed, the 
back failover action can be initiated by the TSA operator using TSA move request.

The installation is performed via an installation script that verifies the prerequisites and installs 
TSAMP. This section will perform the prereq check before invoking the install.

All of the following steps must be performed on both the active and standby nodes unless otherwise 
noted.

Linux Prerequisites
There are several system requirements for TSAMP. Installation must be performed by the root user. 
1. A Korn shell must be installed. This can be verified by searching the installed packages.

rpm -qa | grep ksw

If no packages are returned, then install the ksw package using YaST.

2. Perl is required by TSAMP. It is installed by default with the Linux system. There are some 
issues to be aware of. There are known problems with Perl V5.8.0 and how it handles UTF-89 
encoded locales. The POC system, using SLES 10 SP3 uses Perl V5.8.8. 

If V5.8.0 is used, some steps must be performed to make it functional. See the installation 
guide found in the References section for more details.

3. The 32-bit version of library libstdc++.so.5 is required. 

This can be verified by searching the dictory.
ls /usr/lib/libstdc* 

The returned list should include the following.
/usr/lib/libstdc++.so.5 
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4. There must be at least 100 mb of disk space for /usr/sbin /opt, and /var. This can be verified 
with the command:
df -h

For the POC system, they are each under the root directory.
Filesystem                            Size  Used Avail Use% Mounted on 

/dev/mapper/system-system 18G  6.4G   11G  38%    / 

5. Each node should have at least 128 MB of ram available. 

Install the Software

1. Copy the installation media to a local directory on the node. On the POC environment, it is 
located at /installs/SAfMP_V320_Lnx.tar.  

2. Extract the archive file.
cd /installs
tar -xvf SAfMP_V320_Lnx.tar

3. Change directories to the extracted archive file.
cd /installs/SAM3200MPLinux

4. Perform the prerequisite check.
./prereqSAM

It should provide feedback similar to the following:
prereqSAM: All prerequisites for the TSAMP installation are met on 
operating system: 
SUSE Linux Enterprise Server 10 (s390x) 
VERSION = 10 
PATCHLEVEL = 3 

If the system did not pass the check, correct any problems and try again.
5. Set required environment variable.

TSAMP requires the variable CT_MANAGEMENT_SCOPE to be set to 2 for peer domain 
scope. 

Set the variable for the session
export CT_MANAGEMENT_SCOPE=2

6. Set the variable to be set for each shell.
SLES systems run each script located in /etc/profile.d when a user logs in or starts a shell. 
Create two scripts in this directory to set the variable.
Create files /etc/profile.d/sa_mp.sh  and /etc/profile.d/sa_mp.csh and populate them with 
the value:
export CT_MANAGEMENT_SCOPE=2

Give these scripts executable permissions.
chmod 755 /etc/profile.d/sa_mp*
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7. Continuing from the SAM3200MPLinux directory, launch the install script.
./installSAM

Follow the instructions on the screen to accept the license.
Status will be provided for the RPM packages being installed.

8. Feedback similar to the following should be displayed at the end of the process.

Restart any online domain to activate the new license. 
installSAM: The following license is installed: 
Product: IBM Tivoli System Automation for Multiplatforms 3.2 
Product ID: 101 
Product Annotation: 
Creation date: Tue 18 Aug 2009 08:00:00 PM EDT 
Expiration date: Thu 31 Dec 2037 06:59:59 PM EST 
Subsystem         Group            PID     Status 

 ctrmc            rsct             15559   active 
installSAM: All packages were installed successfully. 

Create the Two-Node Cluster
This section adds the two nodes to a TSA cluster.

1. Network Considerations
The two nodes must be on the same subnet with the same network mask and able to 
communicate with each other. This has already been established in previous sections of the 
document.

2. The nodes must be prepared. On both nodes run the following command.
preprpnode <active node> <standby node>

For the POC environment it is
preprpnode sonnf1 sonnf2

3. The following commands can be performed on either node. 

Create the domain with the following command.
mkrpdomain <domain name> <active node> <standby node>

For the POC environment it is
mkrpdomain cc_domain sonnf1 sonnf2

4. The status of the node can be viewed with
lsrpdomain

It should show a status similar to the following.
Name      OpState RSCTActiveVersion MixedVersions TSPort GSPort 
cc_domain Offline 2.5.5.1           No            12347  12348  

5. Start the domain.

Page 65 of 85      http://www.ibm.com/support/techdocs – WP101738

© International Business Machines Corporation 2010

http://www.ibm.com/support/techdocs


startrpdomain cc_domain

Checking the status again will show a pending online.
Name      OpState          RSCTActiveVersion MixedVersions TSPort GSPort 
cc_domain Pending online 2.5.5.1       No            12347  12348  

After a short time that status will change to Online. 
6. The two-node cluster requires additional configuration to detect network interface failures. 

TSAMP must be configured to contact a network instance outside of the cluster. The best 
practice is to use the default gateway of the subnet.

Create the file /var/ct/cfg/netmon.cf on both nodes and populate it with the default gateway 
information. For example:

#Default gateway for all interfaces 
9.82.24.1

Cluster Verification
This section verifies the TSA cluster configuration.

1. IP filtering must be turned off. On each node issue the following command.
lsrsrc IBM.NetworkInterface Name NodeNameList OpState

If IP filter is turned off, output similar to the following will be displayed. If IP filtering is on, 
no output will be returned. 

Resource Persistent and Dynamic Attributes for IBM.NetworkInterface 
resource 1: 

Name         = "eth0" 
NodeNameList = {"sonnf1.washington.ibm.com"} 
OpState      = 1 

resource 2: 
Name         = "eth0" 
NodeNameList = {"sonnf2.washington.ibm.com"} 
OpState      = 1 

2. Verify that each nodes are aware of each other. 
On each node issue the following.
lsrsrc IBM.PeerNode

Output similar to the following should be displayed.
Resource Persistent Attributes for IBM.PeerNode 
resource 1: 

Name               = "sonnf1" 
NodeList           = {1} 
RSCTVersion        = "2.5.5.1" 
ClassVersions      = {} 
CritRsrcProtMethod = 0 
IsQuorumNode       = 1 
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IsPreferredGSGL    = 1 
ActivePeerDomain   = "cc_domain" 
NodeNameList       = {"sonnf1.washington.ibm.com"} 

resource 2: 
Name               = "sonnf2" 
NodeList           = {2} 
RSCTVersion        = "2.5.5.1" 
ClassVersions      = {} 
CritRsrcProtMethod = 0 
IsQuorumNode       = 1 
IsPreferredGSGL    = 1 
ActivePeerDomain   = "cc_domain" 
NodeNameList       = {"sonnf2.washington.ibm.com"} 

If not all cluster nodes are listed, it is indication that CT_MANAGEMENT_SCOPE=2 may 
not be set.

3. Verify that each node is running the same version of RSCT.
lsrpdomain

The output should indicate that MixedVersions is No. 

If the value is Yes, they can be migrated to the newest version of RSCT with the following 
command.
runact -c IBM.PeerDomain CompleteMigration Options=0

4. Verify TSA is activated.
lssrc -ls IBM.RecoveryRM

In the output that is displayed, the values for IVN and AVN must be equal, such as:
Our IVN              : 3.2.0.0 
Our AVN              : 3.2.0.0 

If they are not, the install must continue to be migrated. 
samctrl -m

Setup a Tie Breaker
A tie breaker must be set up for all clusters that have an even number of nodes. The tie breaker ensures 
that situations can be resolved in which only half of the nodes of the cluster are online.

For a two-node cluster, the following is true.
• Without a tie breaker, TSAMP automates resources only when more than half of the nodes of a 

cluster are online. For a two-node cluster without a tie breaker, this means that both nodes must be 
online for automation to be performed

• A tie breaker ensures that the cluster remains operational even when communication between the 
nodes fail. 

1. This setup uses the default gateway as the tie breaker. This command is quite long, but is just 
one line. The IPAddress is the default gateway
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mkrsrc IBM.TieBreaker Name="iptb" Type="EXEC" 
DeviceInfo='PATHNAME=/usr/sbin/rsct/bin/samtb_net IPAddress=9.82.24.1 
Log=1' PostReserveWaitTime=30

2. This command is performed on only one node, but both nodes should have a message related 
to it in the system log. 

Check the /var/log/messages file on both nodes for a message similar to:
samtb_net[20649]: op=validate ip=9.82.24.1 rc=0 log=1 count=2 

Define the ClearCase Policy
TSAMP operations are policy based. This policy will define system resources to monitor, error 
situations that require action, and the actions to perform. This section goes through the process of 
setting up the required resources for the policy.
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1. As part of the definition of the application for ClearCase, scripts must be defined for starting, 
stopping, and querying the ClearCase server. These are defined in Appendix A and must be 
placed in the same location on both nodes. For the POC, these exist at /home/ccadmin. Place 
these scripts on both nodes, at that location, with executable permissions. 

2. The definition of the application resource that defines ClearCase can be involved, making the 
creation with command line parameters problematic. TSAMP allows for the use of a file to be 
used as input to the command. 
Create a definition file named cc.def that describes ClearCase with the following format:
PersistentResourceAttributes::
     Name="cc"
     StartCommand="/home/ccadmin/cconline > /dev/null 2>&1"
     StopCommand="/home/ccadmin/ccoffline > /dev/null 2>&1"
     MonitorCommand="/home/ccadmin/status"
     MonitorCommandPeriod=30
     MonitorCommandTimeout=20
     NodeNameList={“sonnf1”, “sonnf2”}
     StartCommandTimeout=60
     StopCommandTimeout=60
     UserName="root"
     ResourceType=1

3. Create the cc application based on the definition file. 
mkrsrc -f cc.def IBM.Application

Verify the creastion of the cc application.
lsrsrc -Ab IBM.Application

There will be three cc resources in the output: two constituents (ResourceType=0)defined for 
each node, and one aggregated or floating (ResourceType=1) defined for both nodes.

The ouput of the command is quote large. Inspect sections of it, such as the following:

Resource Persistent and Dynamic Attributes for IBM.Application
resource 1:
        Name                  = "cc"
        ResourceType          = 0
        AggregateResource     = "0x2028 0xffff 0x08cb40b8 0x3f97aeb3 0x91b10526 0x592e59b8"
        StartCommand          = "/home/ccadmin/cconline > /dev/null 2>&1"
        StopCommand           = "/home/ccadmin/ccoffline > /dev/null 2>&1"
        MonitorCommand        = "/home/ccadmin/status"
        MonitorCommandPeriod  = 30
        MonitorCommandTimeout = 20
        StartCommandTimeout   = 60
        StopCommandTimeout    = 60
        UserName              = "root"
  NodeNameList          = {"sonnf1.washington.ibm.com"}
...
...
resource 2:
        Name                  = "cc"
        ResourceType          = 0
        AggregateResource     = "0x2028 0xffff 0x08cb40b8 0x3f97aeb3 0x91b10526 0x592e59b8"
        StartCommand          = "/home/ccadmin/cconline > /dev/null 2>&1"
        StopCommand           = "/home/ccadmin/ccoffline > /dev/null 2>&1"
        MonitorCommand        = "/home/ccadmin/status"
        MonitorCommandPeriod  = 30
        MonitorCommandTimeout = 20
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        StartCommandTimeout   = 60
        StopCommandTimeout    = 60
        UserName              = "root"

NodeNameList          = {"sonnf2.washington.ibm.com"}
...
resource 3:
        Name                  = "cc"
        ResourceType          = 1
        AggregateResource     = "0x3fff 0xffff 0x00000000 0x00000000 0x00000000 0x00000000"
        StartCommand          = "/home/ccadmin/cconline > /dev/null 2>&1"
        StopCommand           = "/home/ccadmin/ccoffline > /dev/null 2>&1"
        MonitorCommand        = "/home/ccadmin/status"
        MonitorCommandPeriod  = 30
        MonitorCommandTimeout = 20
        StartCommandTimeout   = 60
        StopCommandTimeout    = 60
        UserName              = "root"

NodeNameList          = {"sonnf1.washington.ibm.com","sonnf2.washington.ibm.com"}

4. Create the service IP definition. This will use the command line parameters to specify the 
service IP to TSAMP.
mkrsrc IBM.ServiceIP NodeNameList="{'sonnf1', 'sonnf2'}" Name="cc-ip" NetMask=255.255.255.0 
IPAddress=9.82.24.170

Note: The service IPAddress must be a free IP not being used or controlled by a third party. It 
must only be accessed by TSAMP.

Verify the creattion of the cc-ip application.
lsrsrc -Ab IBM.ServiceIP

There will be three cc-ip resources in the output: two constituents (ResourceType=0)defined 
for each node, and one aggregated or floating (ResourceType=1) defined for both nodes.

The output is not as large as the previous application.

Resource Persistent and Dynamic Attributes for IBM.ServiceIP
resource 1:
        Name              = "cc-ip"
        ResourceType      = 0
        AggregateResource = "0x2029 0xffff 0x08cb40b8 0x3f97aeb3 0x91b1040b 0xcd0a3698"
        IPAddress         = "9.82.24.170"
        NetMask           = "255.255.255.0"
        ProtectionMode    = 1
        NetPrefix         = 0
        ActivePeerDomain  = "CITI_CC"
        NodeNameList      = {"sonnf2.washington.ibm.com"}
        OpState           = 1
        ConfigChanged     = 0
        ChangedAttributes = {}
resource 2:
        Name              = "cc-ip"
        ResourceType      = 0
        AggregateResource = "0x2029 0xffff 0x08cb40b8 0x3f97aeb3 0x91b1040b 0xcd0a3698"
        IPAddress         = "9.82.24.170"
        NetMask           = "255.255.255.0"
        ProtectionMode    = 1
        NetPrefix         = 0
        ActivePeerDomain  = "CITI_CC"
        NodeNameList      = {"sonnf1.washington.ibm.com"}
        OpState           = 2
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        ConfigChanged     = 0
        ChangedAttributes = {}
resource 3:
        Name              = "cc-ip"
        ResourceType      = 1
        AggregateResource = "0x3fff 0xffff 0x00000000 0x00000000 0x00000000 0x00000000"
        IPAddress         = "9.82.24.170"
        NetMask           = "255.255.255.0"
        ProtectionMode    = 1
        NetPrefix         = 0
        ActivePeerDomain  = "CITI_CC"
        NodeNameList      = {"sonnf1.washington.ibm.com","sonnf2.washington.ibm.com"}
        OpState           = 1
        ConfigChanged     = 0
        ChangedAttributes = {}

5. TSAMP automatically harvested the mount point information from /etc/fstab.
Verify that each FSID for the shared disk on each node is the identical.
lsrsrc -s "SysMountPoint='/opt/ibm/IMShared'" IBM.AgFileSystem | grep FSID 

The resulting output should show three identical FSID entries.
FSID               = "310a8daa-ce5a-4e0c-80ce-7ff92e4bc877" 
FSID               = "310a8daa-ce5a-4e0c-80ce-7ff92e4bc877" 
FSID               = "310a8daa-ce5a-4e0c-80ce-7ff92e4bc877"

6. Name the resource to an appropriate name.
chrsrc -s "SysMountPoint='/opt/ibm/IMShared'" IBM.AgFileSystem 
Name="opt_ibm_IMShared"

7. Add the nodes' ethernet equivalency cards to the policy.
mkequ netequ IBM.NetworkInterface:eth0:sonnf1,eth0:sonnf2 

8. Create a resource group for ClearCase.
mkrg cc-rg

9. After the defined resources have become resource group members, they will be stopped by 
TSA, because the current Nominal State of cc-rg is Offline. To integrate the TSA policy into a 
running ClearCase environment without having to restart the resources, perform the 
following:

Set NominalState of cc-rg to Online.
chrg -o online cc-rg

Suspend automation of cc-rg
rgreq -o lock cc-rg

After performing the relationships definition in step 11, automation will be resumed.

Add the ClearCase application resources to the resource group.
addrgmbr -g cc-rg IBM.Application:cc
addrgmbr -g cc-rg IBM.ServiceIP:cc-ip

10. Add the mount point to the resource group.
addrgmbr -g cc-rg IBM.AgFileSystem:opt_ibm_IMShared 

11. Define relationships for the resources.
ClearCase is dependent on the service IP and the shared mount point.
The service IP is dependent on ethernet devices.
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mkrel -p DependsOn -S IBM.Application:cc -G IBM.ServiceIP:cc-ip DO_cc_to_ip

mkrel -p DependsOn -S IBM.Application:cc -G 
IBM.AgFileSystem:opt_ibm_IMShared DO_cc_to_IMShared

mkrel -p DependsOn -S IBM.ServiceIP:cc-ip -G IBM.Equivalency:netequ 
DO_ip_to_nieq

Resume automation on the resource group.

rgreq -o unlock cc-rg

12. View the current managed resources and their states.
lssam -V

The current output shows that all of the newly defined resources are offline, and the network 
interfaces are online. The defined relationships are also displayed.

Offline IBM.ResourceGroup:cc-rg Nominal=Offline 
        |- Offline IBM.AgFileSystem:opt_ibm_IMShared 
                |- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
                '- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
        |- Offline IBM.Application:cc 
                |- Offline IBM.Application:cc:sonnf2
                '- Offline IBM.Application:cc:sonnf1
        '- Offline IBM.ServiceIP:cc-ip 
                |- Offline IBM.ServiceIP:cc-ip:sonnf2
                '- Offline IBM.ServiceIP:cc-ip:sonnf1
Online IBM.Equivalency:netequ 
        |- Online IBM.NetworkInterface:eth0:sonnf2
        '- Online IBM.NetworkInterface:eth0:sonnf1

Start Up and Bring Down the Resourcess

1. To start up the ClearCase application set the Nominal State of the resource group cc-rg to 
online.

chrg -o online cc-rg

2. Verify the system status.
lssam

After a moment, all three resources will indicate online on node sonnf1 and offline on node 
sonnf2.

Online IBM.ResourceGroup:cc-rg Nominal=Online
        |- Online IBM.AgFileSystem:opt_ibm_IBMShared 
                |- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
                '- Online IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
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        |- Online IBM.Application:cc 
                |- Offline IBM.Application:cc:sonnf2
                '- Online IBM.Application:cc:sonnf1
        '- Online IBM.ServiceIP:cc-ip 
                |- Offline IBM.ServiceIP:cc-ip:sonnf2
                '- Online IBM.ServiceIP:cc-ip:sonnf1
Online IBM.Equivalency:netequ 
        |- Online IBM.NetworkInterface:eth0:sonnf2
        '- Online IBM.NetworkInterface:eth0:sonnf1

3. Further verification can be performed on both nodes.

Verify the shared disk is mounted on sonnf1 and not sonnf2 by performing 
df -h on both and examining the results.

Verify ClearCase is running on sonnf1 and not on sonnf2 by performing 
ps -ef | grep albd on both nodes.
Sonnf1 will show a running process and sonnf2 will not.

Verify the service IP is on sonnf1by performing ifconfig on both nodes.
Sonnf1 will shoe the alias as being assigned to eth0:1 and sonnf2 will not.

4. To shut down the ClearCase application and unmount the data,  set the Nominal State of the 
resource group cc-rg to offline:

chrg -o offline cc-rg

5. Verify the system status.
lssam

After a moment, all three resources will be indicated offline on both nodes.

Offline IBM.ResourceGroup:cc-rg Nominal=Offline 
        |- Offline IBM.AgFileSystem:opt_ibm_IMShared 
                |- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
                '- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
        |- Offline IBM.Application:cc 
                |- Offline IBM.Application:cc:sonnf2
                '- Offline IBM.Application:cc:sonnf1
        '- Offline IBM.ServiceIP:cc-ip 
                |- Offline IBM.ServiceIP:cc-ip:sonnf2
                '- Offline IBM.ServiceIP:cc-ip:sonnf1
Online IBM.Equivalency:netequ 
        |- Online IBM.NetworkInterface:eth0:sonnf2
        '- Online IBM.NetworkInterface:eth0:sonnf1

6. Further verification can be performed on both nodes.

Verify the shared disk is unmounted on both nodes by performing 
df -h on both and examining the results.

Verify ClearCase is not running by performing 
ps -ef | grep albd on both nodes.
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Verify the service IP is not pingable and inactive by performing ifconfig on both nodes. The 
alias on eth0 will disappear. 

Planned Failover (Maintenance)
In maintenance situations, cc-rg can failover from one node to the other.This section assumes that cc-rg 
is running on sonnf1. 

Online IBM.ResourceGroup:cc-rg Nominal=Online
        |- Online IBM.AgFileSystem:opt_ibm_IBMShared 
                |- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
                '- Online IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
        |- Online IBM.Application:cc 
                |- Offline IBM.Application:cc:sonnf2
                '- Online IBM.Application:cc:sonnf1
        '- Online IBM.ServiceIP:cc-ip 
                |- Offline IBM.ServiceIP:cc-ip:sonnf2
                '- Online IBM.ServiceIP:cc-ip:sonnf1
Online IBM.Equivalency:netequ 
        |- Online IBM.NetworkInterface:eth0:sonnf2
        '- Online IBM.NetworkInterface:eth0:sonnf1

1. Move cc-rg to sonnf2:

rgreq -o move cc-rg

2. The resources of cc-rg will be gently shut down on sonnf1 and restarted on sonnf2 according to 
relationships between them.

Online IBM.ResourceGroup:cc-rg Nominal=Online
        |- Online IBM.AgFileSystem:opt_ibm_IBMShared 
                |- Online IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
                '- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
        |- Online IBM.Application:cc 
                |- Online IBM.Application:cc:sonnf2
                '- Offline IBM.Application:cc:sonnf1
        '- Online IBM.ServiceIP:cc-ip 
                |- Online IBM.ServiceIP:cc-ip:sonnf2
                '- Offline IBM.ServiceIP:cc-ip:sonnf1
Online IBM.Equivalency:netequ 
        |- Online IBM.NetworkInterface:eth0:sonnf2
        '- Online IBM.NetworkInterface:eth0:sonnf1

3. To failover cc-rg back to sonnf1, repeat the same move request.

rgreq -o move cc-rg
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Non-Planned Outage
TSA can be used to simulate a system outage. This section assumes that cc-rg group is running on 
sonnf1 and simulate a crash test by means of a power failure.

1. Reboot sonnf1 by issuing the following on sonnf1.
shutdown -r now

2. In around 30 seconds, TSA will restart the resources on sonnf2. Perform the following on 
sonnf2.
lssam 

Online IBM.ResourceGroup:cc-rg Nominal=Online
        |- Online IBM.AgFileSystem:opt_ibm_IBMShared 
                |- Online IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
                '- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
        |- Online IBM.Application:cc 
                |- Online IBM.Application:cc:sonnf2
                '- Offline IBM.Application:cc:sonnf1
        '- Online IBM.ServiceIP:cc-ip 
                |- Online IBM.ServiceIP:cc-ip:sonnf2
                '- Offline IBM.ServiceIP:cc-ip:sonnf1
Online IBM.Equivalency:netequ 
        |- Online IBM.NetworkInterface:eth0:sonnf2
        '- Online IBM.NetworkInterface:eth0:sonnf1

3. Once sonnf1 has completed the reboot, the lssam command will show the resources on sonnf1 
as being offline.

Save the Policy as an XML File
The active policy can be saved as an XML file and ported to other ClearCse environments, with only an 
adjustment of the domain name, node names, and IP addresses.

sampolicy -s cc_policy.xml

To activate a policy on other system

sampolicy -a cc_policy.xml

The exported policy from the POC environment can be found in Appendix C.

When a TSA policy is activated, the resources are restarted by TSA. The resources should be stopped 
before activating the policy. To avoid the restart effect, set the automation into manual mode before 
activation, with the following command. 

samctrl -M T

Check the TSA mode with the following.

lssamctrl
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After the policy has been activated (sampolicy -a),  the resources will be online on the node they were 
running on previously.

lssam

TSA can then be turned into auto mode with the following.

samctrl -M F
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Appendix A: ClearCase Scripts

For the POC environment the three scripts cconline, ccoffline and status have to be reside in the local 
directory /home/ccadmin on both nodes. If this differs, the definition of the TSA ClearCase applications 
must point to the correct location of the scripts.

cconline

#! /bin/bash
# cconline - Start ClearCase
#

if [ ! -f /opt/rational/clearcase/bin/cleartool ] ; then
echo "this is not a ClearCase host"
exit
fi
# Start ClearCase

/opt/rational/clearcase/etc/atria_start start

ccoffline

#! /bin/ksh
# ccoffline - Stop ClearCase cleanly, wait for all ClearCase processes to exit
#
PSOPTS="-ef"
if [ ! -f /opt/rational/clearcase/bin/cleartool ] ; then
echo "this is not a ClearCase host"
exit
fi
# Stop ClearCase
/opt/rational/clearcase/etc/atria_start stop 
# Wait for all ClearCase processes to exit
ccend="0"
while [ "$ccend" == 0 ]
do
PID=`ps $PSOPTS | grep '(albd_server|admin_server|ccfs_server|credmap_server|
db_server|mntrpc_server|msadm_server|promote_server|shipping_server|syncmgr_server|
view_server|vob_server|vobrpc_server)' | grep -v grep`
if [ "${PID}" == "" ] ; then
echo "ClearCase servers have exited."
ccend="1"
else
sleep 1
fi
done

status
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#!/bin/bash
OPSTATE_ONLINE=1
OPSTATE_OFFLINE=2
mypid=$(ps -aef | grep "\/opt\/rational\/clearcase\/etc\/albd_server"|tr -s " "|awk 
'{if ($8=="/opt/rational/clearcase/etc/albd_server") print $2;}')
if [ ! -z $mypid ]
then
RC=${OPSTATE_ONLINE}
else
RC=${OPSTATE_OFFLINE}
fi
#echo $RC
exit $RC
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Appendix B: Command Reference
Determine the Logical 'Volume Manager name of the shared disk.
lvdisplay

Mount the disk
mount /dev/ccvg/cclv /opt/ibm/IMSHARED

Unmount the disk
umount /dev/ccvg/cclv

View mounted disks
df –h

Define IP alias
ifconfig eth0:1 9.82.24.170 netmask 255.255.255.0 up

Remove the IP alias
ifconfig eth0:1 down
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Appendix B: cc_policy.xml
<?xml version="1.0" encoding="UTF-8"?>
<AutomationPolicy productID="SAM" version="3.2"
  xmlns="http://www.ibm.com/TSA/Policy.xsd"
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xsi:schemaLocation="http://www.ibm.com/TSA/Policy.xsd SAMPolicy.xsd">

  <PolicyInformation>
    <PolicyName>XML-saved policy</PolicyName>
    <AutomationDomainName>CITI_CC</AutomationDomainName>
    <PolicyToken>dummy token</PolicyToken>
  </PolicyInformation>

  <ControlInformation>
    <Timeout>60</Timeout>
    <RetryCount>2</RetryCount>
    <ResourceRestartTimeout>5</ResourceRestartTimeout>
  </ControlInformation>

  <ConstituentResource name="cc" class="IBM.Application" node="sonnf1" />

  <ConstituentResource name="cc" class="IBM.Application" node="sonnf2" />

  <ConstituentResource name="cc-ip" class="IBM.ServiceIP" node="sonnf1" />

  <ConstituentResource name="cc-ip" class="IBM.ServiceIP" node="sonnf2" />

  <ResourceReference name="Resource-Reference-IBM.NetworkInterface.R0">
    <ReferencedResource>
      <Name>eth0</Name>
      <Class>IBM.NetworkInterface</Class>
      <Node>sonnf1</Node>
    </ReferencedResource>
  </ResourceReference>

  <ResourceReference name="Resource-Reference-IBM.NetworkInterface.R1">
    <ReferencedResource>
      <Name>eth0</Name>
      <Class>IBM.NetworkInterface</Class>
      <Node>sonnf2</Node>
    </ReferencedResource>
  </ResourceReference>

  <ResourceReference name="Resource-Reference-IBM.AgFileSystem.R2">
    <ReferencedResource>
      <Name>opt_ibm_IMShared</Name>
      <Class>IBM.AgFileSystem</Class>
      <Node></Node>
    </ReferencedResource>
  </ResourceReference>

  <ResourceGroup name="cc-rg" class="IBM.ResourceGroup">
    <DesiredState>Online</DesiredState>
    <Members>
      <MoveGroup name="cc" class="IBM.Application" selectFromPolicy="Ordered" mandatory="true"/>
      <ResourceReference name="Resource-Reference-IBM.AgFileSystem.R2" mandatory="true"/>
      <MoveGroup name="cc-ip" class="IBM.ServiceIP" selectFromPolicy="Ordered" mandatory="true"/>
    </Members>
    <MemberLocation>Collocated</MemberLocation>
    <Priority>0</Priority>
    <AllowedNode>ALL</AllowedNode>
  </ResourceGroup>

  <MoveGroup name="cc" class="IBM.Application">
    <ClassAttributesReference>
      <IBM.ApplicationAttributes name="IBM.Application.A1"/>
    </ClassAttributesReference>
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    <Members>
      <ConstituentResource name="cc" class="IBM.Application" node="sonnf1"/>
      <ConstituentResource name="cc" class="IBM.Application" node="sonnf2"/>
    </Members>
  </MoveGroup>

  <MoveGroup name="cc-ip" class="IBM.ServiceIP">
    <ClassAttributesReference>
      <IBM.ServiceIPAttributes name="IBM.ServiceIP.S1"/>
    </ClassAttributesReference>
    <Members>
      <ConstituentResource name="cc-ip" class="IBM.ServiceIP" node="sonnf1"/>
      <ConstituentResource name="cc-ip" class="IBM.ServiceIP" node="sonnf2"/>
    </Members>
  </MoveGroup>

  <Relationship name="DO_cc_to_ip">
    <Source>
      <MoveGroup name="cc" class="IBM.Application"/>
    </Source>
    <Type>DependsOn</Type>
    <Target>
      <MoveGroup name="cc-ip" class="IBM.ServiceIP"/>
    </Target>
  </Relationship>

  <Relationship name="DO_cc_to_opt_ibm_IMShared">
    <Source>
      <MoveGroup name="cc" class="IBM.Application"/>
    </Source>
    <Type>DependsOn</Type>
    <Target>
      <ResourceReference name="Resource-Reference-IBM.AgFileSystem.R2"/>
    </Target>
  </Relationship>

  <Relationship name="DO_ip_to_nieq">
    <Source>
      <MoveGroup name="cc-ip" class="IBM.ServiceIP"/>
    </Source>
    <Type>DependsOn</Type>
    <Target>
      <Equivalency name="nieq" class="IBM.Equivalency"/>
    </Target>
  </Relationship>

  <Equivalency name="nieq" class="IBM.Equivalency">
    <MinimumNecessary>1</MinimumNecessary>
    <SelectFromPolicy>Any</SelectFromPolicy>
    <Members>
      <ResourceReference name="Resource-Reference-IBM.NetworkInterface.R0"/>
      <ResourceReference name="Resource-Reference-IBM.NetworkInterface.R1"/>
    </Members>
  </Equivalency>

  <IBM.ApplicationAttributes name="IBM.Application.A1" >
    <StartCommand>/home/ccadmin/cconline &gt; /dev/null 2&gt;&amp;1</StartCommand>
    <StopCommand>/home/ccadmin/ccoffline &gt; /dev/null 2&gt;&amp;1</StopCommand>
    <MonitorCommand>/home/ccadmin/status</MonitorCommand>
    <UserName>root</UserName>
    <StartCommandTimeout>60</StartCommandTimeout>
    <StopCommandTimeout>60</StopCommandTimeout>
    <MonitorCommandTimeout>20</MonitorCommandTimeout>
    <MonitorCommandPeriod>30</MonitorCommandPeriod>
    <RunCommandsSync>1</RunCommandsSync>
    <ProtectionMode>1</ProtectionMode>
    <CleanupCommandTimeout>10</CleanupCommandTimeout>
  </IBM.ApplicationAttributes>

  <IBM.ServiceIPAttributes name="IBM.ServiceIP.S1" >
    <IPAddress>9.82.24.170</IPAddress>
    <NetMask>255.255.255.0</NetMask>
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    <ProtectionMode>1</ProtectionMode>
  </IBM.ServiceIPAttributes>

  <IBM.TieBreaker name="iptb" class="IBM.TieBreaker" >
    <Type>EXEC</Type>
    <Active>true</Active>
    <PreReserveWaitTime>0</PreReserveWaitTime>
    <PostReserveWaitTime>30</PostReserveWaitTime>
    <ReleaseRetryPeriod>0</ReleaseRetryPeriod>
    <HeartbeatPeriod>0</HeartbeatPeriod>
    <DeviceInfo>PATHNAME=/usr/sbin/rsct/bin/samtb_net IPAddress=9.82.24.1 Log=1</DeviceInfo>
  </IBM.TieBreaker>
</AutomationPolicy>
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Appendix D: References
Tivoli System Automation for Multiplatforms Home Page

http://www-01.ibm.com/software/tivoli/products/sys-auto-multi/

Tivoli System Automation for Multiplatforms Manuals

http://publib.boulder.ibm.com/infocenter/tivihelp/v3r1/index.jsp?
topic=/com.ibm.samp.doc_3.2/welcome.html

Rational ClearCase Home Page

http://www-01.ibm.com/software/awdtools/clearcase/

Rational ClearCase Information Center

http://www-01.ibm.com/support/docview.wss?rs=984&uid=swg27010158

Linux on IBM System Z Home Page 

http://www-03.ibm.com/systems/z/os/linux/

z/VM and Linux on IBM System z The Virtualization Cookbook for SLES 10 SP2

http://www.redbooks.ibm.com/abstracts/sg247493.html

Samba Home Page
http://www.samba.org

NFS
http://www.linux.org/docs/ldp/howto/NFS-HOWTO/server.html

IBM SoNAS 
www.ibm.com/systems/storage/network/sonas/
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Appendix E: Notices
Consult your local IBM representative for information on the products and services currently available 
in your area. Any reference to an IBM product, program, or service is not intended to state or imply that 
only that IBM product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may be used instead. 
However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, 
program, or service.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION 
"AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow 
disclaimer of express or implied warranties in certain transactions, therefore, this statement may not 
apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the information. 
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this 
information at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not 
in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may not offer the products, programs, services or features discussed herein in other countries, and 
the information may be subject to change without notice. 

General availability may vary by geography.

IBM may have patents or pending patent applications covering subject matter in this presentation. The 
furnishing of this presentation does not give you any license to these patents. Send license inquires, in 
writing, to IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 
10594.

All statements regarding IBM's future direction and intent are subject to change or withdrawal without 
notice, and represent goals and objectives only.

Any performance data contained in this document was determined in a controlled environment. Results 
obtained in other operating environments may vary significantly.
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Appendix F: Trademarks and copyrights
This work represents the view of the author and does not necessarily represent the view of IBM.

IBM, IBM (logo), e-business (logo), pSeries, e (logo) server, System Z, and xSeries are trademarks or 
registered trademarks of International Business Machines Corporation in the United States and/or other 
countries.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both. 

Linux is a registered trademark of Linus Torvalds.

Red Hat is a registered trademark of Red Hat, Inc. in the United States, other countries, or both.

Novell is a registered trademark and SUSE is a trademark of Novell, Inc. in the United States and other 
countries. 

Windows is a registered trademark of Microsoft Corporation.

Other company, product, and service names may be trademarks or service marks of others.

© International Business Machines Corporation 2010
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	Architecture Use Cases and Design Points
	Setup the Linux on System Z guests with shared storage location area for VOBs and VIEWs 

	Use case 1 Active/Standby Configuration With ECKD Storage
	Advantages of using ECKD storage
	Disadvantages of using ECKD storage

	Usescase 2  Active/Standby configuration with Network Attached Storage
	Advantages of using NAS storage
	Disadvantages of using NAS storage


	Chapter 2 Infrastructure and Installation of Rational ClearCase
	Architecture
	Hardware
	Software
	System configuration
	Network
	User and Group Considerations
	Licensing Considerations
	Rational ClearCase can use Rational Common Licensing or ClearCase Licensing. Common Licensing requires an external License server that can be accessed by various Rational installations. ClearCase Licensing runs with the ClearCase server, does not require additional setup or resources, and can be accessed by other ClearCase installations.
	This document uses the proprietary Atria Licensing that is installed with ClearCase. The license provided to the tool is specific to the ClearCase server hardware. In an HA environment, where one server is running at a time, both nodes must have their own specific licenses installed. 

	Installation and Configuration IBM Rational ClearCase V7.1.1.1
	Accessing the Linux Guest
	The POC installation and configuration of the ClearCase nodes used the graphical interface. Linux on System z installations should have a VNC server configured and running by default.
	Prepare the Installation Media
	Obtain Licenses
	Active Node
	Prepare the Operating System

	Create the ClearCase user group and admin user. 
	useradd –G ccgroup ccadmin 
	Set the password for ccadmin
	passwd ccadmin
	Enter a password when prompted.
	Use YaST to install libstdc++33-32bit 
	Install ClearCase

	The active node now has the ClearCase infrastructure installed and ready to use. 

	Samba (Use Case 1 only)
	Samba is an Open Source suite that provides file and print services to SMB/CIFS clients.  Samba allows for interoperability between Linux/Unix servers and Windows-based clients. To expose locally mounted disks on the Linux Server image to ClearCase Windows clients SAMBA is required.  If SoNAS or other NAS device is used this is not required as NAS devices support CIF,  thus clients can connect directly to device 
	For a Windows workstation to have acess to the ClearCase infrastructure running on Linux on System z, the server must have Samba installed and configured. 
	This section installs and configures Samba on the ClearCase server. 
	The Samba Web Administration Tool (SWAT), provides a Web accessible configuration tool. It must be configured before it is available for use. 
	Enable SWAT
	Configure the server
	Configure the Samba Users

	The server is now configured to share files through Samba.
	Standby Node
	The purpose of the standby node is to be identical to the active node. When the system fails over, it must appear to attached clients as if nothing has changed. This document will not reproduce the steps already described in the active node and samba server sections, though they must be repeated for the standby node. This section identifies standby node considerations.
	The standby node is now configured to be identical to the active node. It will be configured to take over the ClearCase artifacts in a later chapter.
	                                                                                                                                                                                                               


	Chapter 3 Configure ClearCase for HA
	Registry
	VOB
	View
	Views provide several important functions: 
	Access to VOB data 
	Workspaces where users can modify VOB data 
	Short-term storage for other data created during the development process 
	A typical view contains a combination of versioned artifacts (versions of VOB elements) and unversioned artifacts (view-private files that do not exist in any VOB).
	This POC uses Dynamic views. Dynamic views provide transparent access to versions of elements in the VOB and to view-private objects. A dynamic view can access any version of an element selected by the view's config spec as soon as the version is checked in. 
	The view must be created in association with the service hostname and IP.
	Region
	The Windows workstations will belong to an additional region. It must be created on the server.

	Chapter 4 Configuring a Local client on Workstation
	Install Rational ClearCase on Workstation
	Configure Rational ClearCase on Workstation
	Import Host VOB and View
	Use the VOB and View


	Chapter 5 ClearCase Failover 
	At this point in the document, there is an active node and a standby node configured with ClearCase servers. The active node is assigned the service IP and has the shared data mounted to local directories. There are two clients configured to use the active node, accessing the service IP. 
	Manual Failover
	This section goes through the manual process of failing over to the standby node. In the next section, this process will be automated.
	Shutdown the Active Node
	This section is performed on the active node.
	Windows Client
	Linux Client

	Chapter 6 Install and configure TSA for Multiplatforms 
	The manual failover procedure identified four items:
	Stop and start ClearCase
	Stop and start Samba and NFS (Use Case 1 only)
	Unmount and mount the shared drive
	Assign the service IP alias
	Tivoli System Automation for Multiplatforms (TSAMP) will be used to control these processes. It will detect when the active node has gone down and will perform the procedure described in the previous section.
	Install TSA for Multiplatforms
	TSA must be installed on each node. It will monitor when the active node, ClearCase process, IP or storage become unavailable and then failover to the standby node. Reverting the resources back to the active node will not happen automatically by TSA to avoid undesired system behavior. If needed, the back failover action can be initiated by the TSA operator using TSA move request.
	The installation is performed via an installation script that verifies the prerequisites and installs TSAMP. This section will perform the prereq check before invoking the install.

	All of the following steps must be performed on both the active and standby nodes unless otherwise noted.
	Linux Prerequisites
	There are several system requirements for TSAMP. Installation must be performed by the root user. 
	Install the Software
	Copy the installation media to a local directory on the node. On the POC environment, it is located at /installs/SAfMP_V320_Lnx.tar.  
	Extract the archive file.
	cd /installs
	tar -xvf SAfMP_V320_Lnx.tar
	Change directories to the extracted archive file.
	cd /installs/SAM3200MPLinux
	Perform the prerequisite check.
	./prereqSAM
	It should provide feedback similar to the following:
	prereqSAM: All prerequisites for the TSAMP installation are met on operating system: 
	SUSE Linux Enterprise Server 10 (s390x) 
	VERSION = 10 
	PATCHLEVEL = 3 
	If the system did not pass the check, correct any problems and try again.
	Set required environment variable.
	TSAMP requires the variable CT_MANAGEMENT_SCOPE to be set to 2 for peer domain scope. 
	Set the variable for the session
	export CT_MANAGEMENT_SCOPE=2
	Set the variable to be set for each shell.
	SLES systems run each script located in /etc/profile.d when a user logs in or starts a shell. 
	Create two scripts in this directory to set the variable.
	Create files /etc/profile.d/sa_mp.sh  and /etc/profile.d/sa_mp.csh and populate them with the value:
	export CT_MANAGEMENT_SCOPE=2
	Give these scripts executable permissions.
	chmod 755 /etc/profile.d/sa_mp*
	Continuing from the SAM3200MPLinux directory, launch the install script.
	./installSAM
	Follow the instructions on the screen to accept the license.
	Status will be provided for the RPM packages being installed.
	Feedback similar to the following should be displayed at the end of the process.
	Restart any online domain to activate the new license. 
	installSAM: The following license is installed: 
	Product: IBM Tivoli System Automation for Multiplatforms 3.2 
	Product ID: 101 
	Product Annotation: 
	Creation date: Tue 18 Aug 2009 08:00:00 PM EDT 
	Expiration date: Thu 31 Dec 2037 06:59:59 PM EST 
	Subsystem         Group            PID     Status 
	 ctrmc            rsct             15559   active 
	installSAM: All packages were installed successfully. 
	Create the Two-Node Cluster
	This section adds the two nodes to a TSA cluster.
	Network Considerations
	The two nodes must be on the same subnet with the same network mask and able to communicate with each other. This has already been established in previous sections of the document.
	The nodes must be prepared. On both nodes run the following command.
	preprpnode <active node> <standby node>
	For the POC environment it is
	preprpnode sonnf1 sonnf2
	The following commands can be performed on either node. 
	Create the domain with the following command.
	mkrpdomain <domain name> <active node> <standby node>
	For the POC environment it is
	mkrpdomain cc_domain sonnf1 sonnf2
	The status of the node can be viewed with
	lsrpdomain
	It should show a status similar to the following.
	Name      OpState RSCTActiveVersion MixedVersions TSPort GSPort 
	cc_domain Offline 2.5.5.1           No            12347  12348  
	Start the domain.
	startrpdomain cc_domain
	Checking the status again will show a pending online.
	Name      OpState          RSCTActiveVersion MixedVersions TSPort GSPort 
	cc_domain Pending online 2.5.5.1       No            12347  12348  
	After a short time that status will change to Online. 
	The two-node cluster requires additional configuration to detect network interface failures.  TSAMP must be configured to contact a network instance outside of the cluster. The best practice is to use the default gateway of the subnet.
	Create the file /var/ct/cfg/netmon.cf on both nodes and populate it with the default gateway information. For example:
	#Default gateway for all interfaces 
	9.82.24.1
	Cluster Verification
	This section verifies the TSA cluster configuration.
	lsrsrc IBM.NetworkInterface Name NodeNameList OpState
	If IP filter is turned off, output similar to the following will be displayed. If IP filtering is on, no output will be returned. 
	Resource Persistent and Dynamic Attributes for IBM.NetworkInterface 
	resource 1: 
		Name         = "eth0" 
		NodeNameList = {"sonnf1.washington.ibm.com"} 
		OpState      = 1 
	resource 2: 
		Name         = "eth0" 
		NodeNameList = {"sonnf2.washington.ibm.com"} 
		OpState      = 1 
	Verify that each nodes are aware of each other. 
	On each node issue the following.
	lsrsrc IBM.PeerNode
	Output similar to the following should be displayed.
	Resource Persistent Attributes for IBM.PeerNode 
	resource 1: 
		Name               = "sonnf1" 
		NodeList           = {1} 
		RSCTVersion        = "2.5.5.1" 
		ClassVersions      = {} 
		CritRsrcProtMethod = 0 
		IsQuorumNode       = 1 
		IsPreferredGSGL    = 1 
		ActivePeerDomain   = "cc_domain" 
		NodeNameList       = {"sonnf1.washington.ibm.com"} 
	resource 2: 
		Name               = "sonnf2" 
		NodeList           = {2} 
		RSCTVersion        = "2.5.5.1" 
		ClassVersions      = {} 
		CritRsrcProtMethod = 0 
		IsQuorumNode       = 1 
		IsPreferredGSGL    = 1 
		ActivePeerDomain   = "cc_domain" 
		NodeNameList       = {"sonnf2.washington.ibm.com"} 
	If not all cluster nodes are listed, it is indication that CT_MANAGEMENT_SCOPE=2 may not be set.
	Verify that each node is running the same version of RSCT.
	lsrpdomain
	The output should indicate that MixedVersions is No. 
	If the value is Yes, they can be migrated to the newest version of RSCT with the following command.
	runact -c IBM.PeerDomain CompleteMigration Options=0
	Verify TSA is activated.
	lssrc -ls IBM.RecoveryRM
	In the output that is displayed, the values for IVN and AVN must be equal, such as:
	Our IVN              : 3.2.0.0 
	Our AVN              : 3.2.0.0 
	If they are not, the install must continue to be migrated. 
	samctrl -m
	Setup a Tie Breaker
	A tie breaker must be set up for all clusters that have an even number of nodes. The tie breaker ensures that situations can be resolved in which only half of the nodes of the cluster are online.
	For a two-node cluster, the following is true.
	Without a tie breaker, TSAMP automates resources only when more than half of the nodes of a cluster are online. For a two-node cluster without a tie breaker, this means that both nodes must be online for automation to be performed
	A tie breaker ensures that the cluster remains operational even when communication between the nodes fail. 
	This setup uses the default gateway as the tie breaker. This command is quite long, but is just one line. The IPAddress is the default gateway
	mkrsrc IBM.TieBreaker Name="iptb" Type="EXEC" DeviceInfo='PATHNAME=/usr/sbin/rsct/bin/samtb_net IPAddress=9.82.24.1  Log=1' PostReserveWaitTime=30

	This command is performed on only one node, but both nodes should have a message related to it in the system log. 
	Check the /var/log/messages file on both nodes for a message similar to:
	samtb_net[20649]: op=validate ip=9.82.24.1 rc=0 log=1 count=2 
	Define the ClearCase Policy
	TSAMP operations are policy based. This policy will define system resources to monitor, error situations that require action, and the actions to perform. This section goes through the process of setting up the required resources for the policy.
	As part of the definition of the application for ClearCase, scripts must be defined for starting, stopping, and querying the ClearCase server. These are defined in Appendix A and must be placed in the same location on both nodes. For the POC, these exist at /home/ccadmin. Place these scripts on both nodes, at that location, with executable permissions. 
	The definition of the application resource that defines ClearCase can be involved, making the creation with command line parameters problematic. TSAMP allows for the use of a file to be used as input to the command. 
	Create a definition file named cc.def that describes ClearCase with the following format:
	PersistentResourceAttributes::
	     Name="cc"
	     StartCommand="/home/ccadmin/cconline > /dev/null 2>&1"
	     StopCommand="/home/ccadmin/ccoffline > /dev/null 2>&1"
	     MonitorCommand="/home/ccadmin/status"
	     MonitorCommandPeriod=30
	     MonitorCommandTimeout=20
	     NodeNameList={“sonnf1”, “sonnf2”}
	     StartCommandTimeout=60
	     StopCommandTimeout=60
	     UserName="root"
	     ResourceType=1
	Create the cc application based on the definition file. 
	mkrsrc -f cc.def IBM.Application
	Verify the creastion of the cc application.
	lsrsrc -Ab IBM.Application
	There will be three cc resources in the output: two constituents (ResourceType=0)defined for each node, and one aggregated or floating (ResourceType=1) defined for both nodes.
	The ouput of the command is quote large. Inspect sections of it, such as the following:
	Resource Persistent and Dynamic Attributes for IBM.Application
	resource 1:
	        Name                  = "cc"
	        ResourceType          = 0
	        AggregateResource     = "0x2028 0xffff 0x08cb40b8 0x3f97aeb3 0x91b10526 0x592e59b8"
	        StartCommand          = "/home/ccadmin/cconline > /dev/null 2>&1"
	        StopCommand           = "/home/ccadmin/ccoffline > /dev/null 2>&1"
	        MonitorCommand        = "/home/ccadmin/status"
	        MonitorCommandPeriod  = 30
	        MonitorCommandTimeout = 20
	        StartCommandTimeout   = 60
	        StopCommandTimeout    = 60
	        UserName              = "root"
	 	 NodeNameList          = {"sonnf1.washington.ibm.com"}
	...
	...
	resource 2:
	        Name                  = "cc"
	        ResourceType          = 0
	        AggregateResource     = "0x2028 0xffff 0x08cb40b8 0x3f97aeb3 0x91b10526 0x592e59b8"
	        StartCommand          = "/home/ccadmin/cconline > /dev/null 2>&1"
	        StopCommand           = "/home/ccadmin/ccoffline > /dev/null 2>&1"
	        MonitorCommand        = "/home/ccadmin/status"
	        MonitorCommandPeriod  = 30
	        MonitorCommandTimeout = 20
	        StartCommandTimeout   = 60
	        StopCommandTimeout    = 60
	        UserName              = "root"
		NodeNameList          = {"sonnf2.washington.ibm.com"}
	...
	resource 3:
	        Name                  = "cc"
	        ResourceType          = 1
	        AggregateResource     = "0x3fff 0xffff 0x00000000 0x00000000 0x00000000 0x00000000"
	        StartCommand          = "/home/ccadmin/cconline > /dev/null 2>&1"
	        StopCommand           = "/home/ccadmin/ccoffline > /dev/null 2>&1"
	        MonitorCommand        = "/home/ccadmin/status"
	        MonitorCommandPeriod  = 30
	        MonitorCommandTimeout = 20
	        StartCommandTimeout   = 60
	        StopCommandTimeout    = 60
	        UserName              = "root"
		NodeNameList          = {"sonnf1.washington.ibm.com","sonnf2.washington.ibm.com"}

	Create the service IP definition. This will use the command line parameters to specify the service IP to TSAMP.
	mkrsrc IBM.ServiceIP NodeNameList="{'sonnf1', 'sonnf2'}" Name="cc-ip" NetMask=255.255.255.0 IPAddress=9.82.24.170
	Note: The service IPAddress must be a free IP not being used or controlled by a third party. It must only be accessed by TSAMP.
	Verify the creattion of the cc-ip application.
	lsrsrc -Ab IBM.ServiceIP

	There will be three cc-ip resources in the output: two constituents (ResourceType=0)defined for each node, and one aggregated or floating (ResourceType=1) defined for both nodes.
	The output is not as large as the previous application.
	Resource Persistent and Dynamic Attributes for IBM.ServiceIP
	resource 1:
	        Name              = "cc-ip"
	        ResourceType      = 0
	        AggregateResource = "0x2029 0xffff 0x08cb40b8 0x3f97aeb3 0x91b1040b 0xcd0a3698"
	        IPAddress         = "9.82.24.170"
	        NetMask           = "255.255.255.0"
	        ProtectionMode    = 1
	        NetPrefix         = 0
	        ActivePeerDomain  = "CITI_CC"
	        NodeNameList      = {"sonnf2.washington.ibm.com"}
	        OpState           = 1
	        ConfigChanged     = 0
	        ChangedAttributes = {}
	resource 2:
	        Name              = "cc-ip"
	        ResourceType      = 0
	        AggregateResource = "0x2029 0xffff 0x08cb40b8 0x3f97aeb3 0x91b1040b 0xcd0a3698"
	        IPAddress         = "9.82.24.170"
	        NetMask           = "255.255.255.0"
	        ProtectionMode    = 1
	        NetPrefix         = 0
	        ActivePeerDomain  = "CITI_CC"
	        NodeNameList      = {"sonnf1.washington.ibm.com"}
	        OpState           = 2
	        ConfigChanged     = 0
	        ChangedAttributes = {}
	resource 3:
	        Name              = "cc-ip"
	        ResourceType      = 1
	        AggregateResource = "0x3fff 0xffff 0x00000000 0x00000000 0x00000000 0x00000000"
	        IPAddress         = "9.82.24.170"
	        NetMask           = "255.255.255.0"
	        ProtectionMode    = 1
	        NetPrefix         = 0
	        ActivePeerDomain  = "CITI_CC"
	        NodeNameList      = {"sonnf1.washington.ibm.com","sonnf2.washington.ibm.com"}
	        OpState           = 1
	        ConfigChanged     = 0
	        ChangedAttributes = {}

	TSAMP automatically harvested the mount point information from /etc/fstab.
	Verify that each FSID for the shared disk on each node is the identical.
	lsrsrc -s "SysMountPoint='/opt/ibm/IMShared'" IBM.AgFileSystem | grep FSID 
	The resulting output should show three identical FSID entries.
		FSID               = "310a8daa-ce5a-4e0c-80ce-7ff92e4bc877" 
		FSID               = "310a8daa-ce5a-4e0c-80ce-7ff92e4bc877" 
		FSID               = "310a8daa-ce5a-4e0c-80ce-7ff92e4bc877"
	Name the resource to an appropriate name.
	chrsrc -s "SysMountPoint='/opt/ibm/IMShared'" IBM.AgFileSystem Name="opt_ibm_IMShared"

	Add the nodes' ethernet equivalency cards to the policy.
	mkequ netequ IBM.NetworkInterface:eth0:sonnf1,eth0:sonnf2 
	Create a resource group for ClearCase.
	mkrg cc-rg
	After the defined resources have become resource group members, they will be stopped by TSA, because the current Nominal State of cc-rg is Offline. To integrate the TSA policy into a running ClearCase environment without having to restart the resources, perform the following:
	Set NominalState of cc-rg to Online.
	chrg -o online cc-rg
	Suspend automation of cc-rg
	rgreq -o lock cc-rg
	After performing the relationships definition in step 11, automation will be resumed.

	Add the ClearCase application resources to the resource group.
	addrgmbr -g cc-rg IBM.Application:cc
	addrgmbr -g cc-rg IBM.ServiceIP:cc-ip
	Add the mount point to the resource group.
	addrgmbr -g cc-rg IBM.AgFileSystem:opt_ibm_IMShared 
	Define relationships for the resources.
	ClearCase is dependent on the service IP and the shared mount point.
	The service IP is dependent on ethernet devices.
	mkrel -p DependsOn -S IBM.Application:cc -G IBM.ServiceIP:cc-ip DO_cc_to_ip
	mkrel -p DependsOn -S IBM.Application:cc -G IBM.AgFileSystem:opt_ibm_IMShared DO_cc_to_IMShared
	mkrel -p DependsOn -S IBM.ServiceIP:cc-ip -G IBM.Equivalency:netequ DO_ip_to_nieq
	Resume automation on the resource group.
	rgreq -o unlock cc-rg
	View the current managed resources and their states.
	lssam -V
	The current output shows that all of the newly defined resources are offline, and the network interfaces are online. The defined relationships are also displayed.
	Offline IBM.ResourceGroup:cc-rg Nominal=Offline 
	        |- Offline IBM.AgFileSystem:opt_ibm_IMShared 
	                |- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
	                '- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
	        |- Offline IBM.Application:cc 
	                |- Offline IBM.Application:cc:sonnf2
	                '- Offline IBM.Application:cc:sonnf1
	        '- Offline IBM.ServiceIP:cc-ip 
	                |- Offline IBM.ServiceIP:cc-ip:sonnf2
	                '- Offline IBM.ServiceIP:cc-ip:sonnf1
	Online IBM.Equivalency:netequ 
	        |- Online IBM.NetworkInterface:eth0:sonnf2
	        '- Online IBM.NetworkInterface:eth0:sonnf1

	Start Up and Bring Down the Resourcess
	To start up the ClearCase application set the Nominal State of the resource group cc-rg to online.
	chrg -o online cc-rg
	Verify the system status.
	lssam
	After a moment, all three resources will indicate online on node sonnf1 and offline on node sonnf2.
	Online IBM.ResourceGroup:cc-rg Nominal=Online
	        |- Online IBM.AgFileSystem:opt_ibm_IBMShared 
	                |- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
	                '- Online IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
	        |- Online IBM.Application:cc 
	                |- Offline IBM.Application:cc:sonnf2
	                '- Online IBM.Application:cc:sonnf1
	        '- Online IBM.ServiceIP:cc-ip 
	                |- Offline IBM.ServiceIP:cc-ip:sonnf2
	                '- Online IBM.ServiceIP:cc-ip:sonnf1
	Online IBM.Equivalency:netequ 
	        |- Online IBM.NetworkInterface:eth0:sonnf2
	        '- Online IBM.NetworkInterface:eth0:sonnf1
	Further verification can be performed on both nodes.
	Verify the shared disk is mounted on sonnf1 and not sonnf2 by performing 
	df -h on both and examining the results.
	Verify ClearCase is running on sonnf1 and not on sonnf2 by performing 
	ps -ef | grep albd on both nodes.
	Sonnf1 will show a running process and sonnf2 will not.
	Verify the service IP is on sonnf1by performing ifconfig on both nodes.
	Sonnf1 will shoe the alias as being assigned to eth0:1 and sonnf2 will not.
	To shut down the ClearCase application and unmount the data,  set the Nominal State of the resource group cc-rg to offline:
	chrg -o offline cc-rg
	Verify the system status.
	lssam
	After a moment, all three resources will be indicated offline on both nodes.
	Offline IBM.ResourceGroup:cc-rg Nominal=Offline 
	        |- Offline IBM.AgFileSystem:opt_ibm_IMShared 
	                |- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
	                '- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
	        |- Offline IBM.Application:cc 
	                |- Offline IBM.Application:cc:sonnf2
	                '- Offline IBM.Application:cc:sonnf1
	        '- Offline IBM.ServiceIP:cc-ip 
	                |- Offline IBM.ServiceIP:cc-ip:sonnf2
	                '- Offline IBM.ServiceIP:cc-ip:sonnf1
	Online IBM.Equivalency:netequ 
	        |- Online IBM.NetworkInterface:eth0:sonnf2
	        '- Online IBM.NetworkInterface:eth0:sonnf1
	Further verification can be performed on both nodes.
	Verify the shared disk is unmounted on both nodes by performing 
	df -h on both and examining the results.
	Verify ClearCase is not running by performing 
	ps -ef | grep albd on both nodes.
	Verify the service IP is not pingable and inactive by performing ifconfig on both nodes. The alias on eth0 will disappear. 
	Planned Failover (Maintenance)

	In maintenance situations, cc-rg can failover from one node to the other.This section assumes that cc-rg is running on sonnf1. 
	Online IBM.ResourceGroup:cc-rg Nominal=Online
	        |- Online IBM.AgFileSystem:opt_ibm_IBMShared 
	                |- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
	                '- Online IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
	        |- Online IBM.Application:cc 
	                |- Offline IBM.Application:cc:sonnf2
	                '- Online IBM.Application:cc:sonnf1
	        '- Online IBM.ServiceIP:cc-ip 
	                |- Offline IBM.ServiceIP:cc-ip:sonnf2
	                '- Online IBM.ServiceIP:cc-ip:sonnf1
	Online IBM.Equivalency:netequ 
	        |- Online IBM.NetworkInterface:eth0:sonnf2
	        '- Online IBM.NetworkInterface:eth0:sonnf1
	Move cc-rg to sonnf2:
	rgreq -o move cc-rg
	The resources of cc-rg will be gently shut down on sonnf1 and restarted on sonnf2 according to relationships between them.
	Online IBM.ResourceGroup:cc-rg Nominal=Online
	        |- Online IBM.AgFileSystem:opt_ibm_IBMShared 
	                |- Online IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
	                '- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
	        |- Online IBM.Application:cc 
	                |- Online IBM.Application:cc:sonnf2
	                '- Offline IBM.Application:cc:sonnf1
	        '- Online IBM.ServiceIP:cc-ip 
	                |- Online IBM.ServiceIP:cc-ip:sonnf2
	                '- Offline IBM.ServiceIP:cc-ip:sonnf1
	Online IBM.Equivalency:netequ 
	        |- Online IBM.NetworkInterface:eth0:sonnf2
	        '- Online IBM.NetworkInterface:eth0:sonnf1
	To failover cc-rg back to sonnf1, repeat the same move request.
	rgreq -o move cc-rg
	Non-Planned Outage

	TSA can be used to simulate a system outage. This section assumes that cc-rg group is running on sonnf1 and simulate a crash test by means of a power failure.
	Reboot sonnf1 by issuing the following on sonnf1.
	shutdown -r now
	In around 30 seconds, TSA will restart the resources on sonnf2. Perform the following on sonnf2.
	lssam 
	Online IBM.ResourceGroup:cc-rg Nominal=Online
	        |- Online IBM.AgFileSystem:opt_ibm_IBMShared 
	                |- Online IBM.AgFileSystem:opt_ibm_IMShared:sonnf2
	                '- Offline IBM.AgFileSystem:opt_ibm_IMShared:sonnf1
	        |- Online IBM.Application:cc 
	                |- Online IBM.Application:cc:sonnf2
	                '- Offline IBM.Application:cc:sonnf1
	        '- Online IBM.ServiceIP:cc-ip 
	                |- Online IBM.ServiceIP:cc-ip:sonnf2
	                '- Offline IBM.ServiceIP:cc-ip:sonnf1
	Online IBM.Equivalency:netequ 
	        |- Online IBM.NetworkInterface:eth0:sonnf2
	        '- Online IBM.NetworkInterface:eth0:sonnf1
	Once sonnf1 has completed the reboot, the lssam command will show the resources on sonnf1 as being offline.
	The active policy can be saved as an XML file and ported to other ClearCse environments, with only an adjustment of the domain name, node names, and IP addresses.
	sampolicy -s cc_policy.xml
	To activate a policy on other system
	sampolicy -a cc_policy.xml
	The exported policy from the POC environment can be found in Appendix C.
	When a TSA policy is activated, the resources are restarted by TSA. The resources should be stopped before activating the policy. To avoid the restart effect, set the automation into manual mode before activation, with the following command. 
	samctrl -M T
	Check the TSA mode with the following.
	lssamctrl
	After the policy has been activated (sampolicy -a),  the resources will be online on the node they were running on previously.
	lssam
	TSA can then be turned into auto mode with the following.
	samctrl -M F

	Appendix A: ClearCase Scripts
	cconline
	ccoffline
	status
	<?xml version="1.0" encoding="UTF-8"?>
	<AutomationPolicy productID="SAM" version="3.2"
	  xmlns="http://www.ibm.com/TSA/Policy.xsd"
	  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
	  xsi:schemaLocation="http://www.ibm.com/TSA/Policy.xsd SAMPolicy.xsd">
	  <PolicyInformation>
	    <PolicyName>XML-saved policy</PolicyName>
	    <AutomationDomainName>CITI_CC</AutomationDomainName>
	    <PolicyToken>dummy token</PolicyToken>
	  </PolicyInformation>
	  <ControlInformation>
	    <Timeout>60</Timeout>
	    <RetryCount>2</RetryCount>
	    <ResourceRestartTimeout>5</ResourceRestartTimeout>
	  </ControlInformation>
	  <ConstituentResource name="cc" class="IBM.Application" node="sonnf1" />
	  <ConstituentResource name="cc" class="IBM.Application" node="sonnf2" />
	  <ConstituentResource name="cc-ip" class="IBM.ServiceIP" node="sonnf1" />
	  <ConstituentResource name="cc-ip" class="IBM.ServiceIP" node="sonnf2" />
	  <ResourceReference name="Resource-Reference-IBM.NetworkInterface.R0">
	    <ReferencedResource>
	      <Name>eth0</Name>
	      <Class>IBM.NetworkInterface</Class>
	      <Node>sonnf1</Node>
	    </ReferencedResource>
	  </ResourceReference>
	  <ResourceReference name="Resource-Reference-IBM.NetworkInterface.R1">
	    <ReferencedResource>
	      <Name>eth0</Name>
	      <Class>IBM.NetworkInterface</Class>
	      <Node>sonnf2</Node>
	    </ReferencedResource>
	  </ResourceReference>
	  <ResourceReference name="Resource-Reference-IBM.AgFileSystem.R2">
	    <ReferencedResource>
	      <Name>opt_ibm_IMShared</Name>
	      <Class>IBM.AgFileSystem</Class>
	      <Node></Node>
	    </ReferencedResource>
	  </ResourceReference>
	  <ResourceGroup name="cc-rg" class="IBM.ResourceGroup">
	    <DesiredState>Online</DesiredState>
	    <Members>
	      <MoveGroup name="cc" class="IBM.Application" selectFromPolicy="Ordered" mandatory="true"/>
	      <ResourceReference name="Resource-Reference-IBM.AgFileSystem.R2" mandatory="true"/>
	      <MoveGroup name="cc-ip" class="IBM.ServiceIP" selectFromPolicy="Ordered" mandatory="true"/>
	    </Members>
	    <MemberLocation>Collocated</MemberLocation>
	    <Priority>0</Priority>
	    <AllowedNode>ALL</AllowedNode>
	  </ResourceGroup>
	  <MoveGroup name="cc" class="IBM.Application">
	    <ClassAttributesReference>
	      <IBM.ApplicationAttributes name="IBM.Application.A1"/>
	    </ClassAttributesReference>
	    <Members>
	      <ConstituentResource name="cc" class="IBM.Application" node="sonnf1"/>
	      <ConstituentResource name="cc" class="IBM.Application" node="sonnf2"/>
	    </Members>
	  </MoveGroup>
	  <MoveGroup name="cc-ip" class="IBM.ServiceIP">
	    <ClassAttributesReference>
	      <IBM.ServiceIPAttributes name="IBM.ServiceIP.S1"/>
	    </ClassAttributesReference>
	    <Members>
	      <ConstituentResource name="cc-ip" class="IBM.ServiceIP" node="sonnf1"/>
	      <ConstituentResource name="cc-ip" class="IBM.ServiceIP" node="sonnf2"/>
	    </Members>
	  </MoveGroup>
	  <Relationship name="DO_cc_to_ip">
	    <Source>
	      <MoveGroup name="cc" class="IBM.Application"/>
	    </Source>
	    <Type>DependsOn</Type>
	    <Target>
	      <MoveGroup name="cc-ip" class="IBM.ServiceIP"/>
	    </Target>
	  </Relationship>
	  <Relationship name="DO_cc_to_opt_ibm_IMShared">
	    <Source>
	      <MoveGroup name="cc" class="IBM.Application"/>
	    </Source>
	    <Type>DependsOn</Type>
	    <Target>
	      <ResourceReference name="Resource-Reference-IBM.AgFileSystem.R2"/>
	    </Target>
	  </Relationship>
	  <Relationship name="DO_ip_to_nieq">
	    <Source>
	      <MoveGroup name="cc-ip" class="IBM.ServiceIP"/>
	    </Source>
	    <Type>DependsOn</Type>
	    <Target>
	      <Equivalency name="nieq" class="IBM.Equivalency"/>
	    </Target>
	  </Relationship>
	  <Equivalency name="nieq" class="IBM.Equivalency">
	    <MinimumNecessary>1</MinimumNecessary>
	    <SelectFromPolicy>Any</SelectFromPolicy>
	    <Members>
	      <ResourceReference name="Resource-Reference-IBM.NetworkInterface.R0"/>
	      <ResourceReference name="Resource-Reference-IBM.NetworkInterface.R1"/>
	    </Members>
	  </Equivalency>
	  <IBM.ApplicationAttributes name="IBM.Application.A1" >
	    <StartCommand>/home/ccadmin/cconline &gt; /dev/null 2&gt;&amp;1</StartCommand>
	    <StopCommand>/home/ccadmin/ccoffline &gt; /dev/null 2&gt;&amp;1</StopCommand>
	    <MonitorCommand>/home/ccadmin/status</MonitorCommand>
	    <UserName>root</UserName>
	    <StartCommandTimeout>60</StartCommandTimeout>
	    <StopCommandTimeout>60</StopCommandTimeout>
	    <MonitorCommandTimeout>20</MonitorCommandTimeout>
	    <MonitorCommandPeriod>30</MonitorCommandPeriod>
	    <RunCommandsSync>1</RunCommandsSync>
	    <ProtectionMode>1</ProtectionMode>
	    <CleanupCommandTimeout>10</CleanupCommandTimeout>
	  </IBM.ApplicationAttributes>
	  <IBM.ServiceIPAttributes name="IBM.ServiceIP.S1" >
	    <IPAddress>9.82.24.170</IPAddress>
	    <NetMask>255.255.255.0</NetMask>
	    <ProtectionMode>1</ProtectionMode>
	  </IBM.ServiceIPAttributes>
	  <IBM.TieBreaker name="iptb" class="IBM.TieBreaker" >
	    <Type>EXEC</Type>
	    <Active>true</Active>
	    <PreReserveWaitTime>0</PreReserveWaitTime>
	    <PostReserveWaitTime>30</PostReserveWaitTime>
	    <ReleaseRetryPeriod>0</ReleaseRetryPeriod>
	    <HeartbeatPeriod>0</HeartbeatPeriod>
	    <DeviceInfo>PATHNAME=/usr/sbin/rsct/bin/samtb_net IPAddress=9.82.24.1 Log=1</DeviceInfo>
	  </IBM.TieBreaker>
	</AutomationPolicy>



